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viiPREFACE

PREFACE

Before you start these tutorials, you should have worked through the 
4th Dimension Quick Start manual. The Quick Start chapters provide you 
with a complete basic introduction to the program. Even if you are 
familiar with 4th Dimension, you should read it through.

This book begins where the Quick Start manual leaves off. The Quick Start 
manual teaches you the basic skills you need to use 4th Dimension 
productively in your own work. The 4th Dimension Tutorials manual is 
designed to help you take advantage of 4th Dimension’s more advanced 
features.

ABOUT THE MANUALS

The manuals described below provide a guide to the features of both 
4th Dimension and 4D Server. The only exception is the 
4D Server Reference which describes features exclusive to 4D Server and is 
included only in the 4D Server documentation package.

The 4th Dimension Quick Start and 4th Dimension Tutorials manuals lead you 
through example lessons where you create and use a 4th Dimension 
database. These examples provide hands-on experience to help you 
become familiar with the concepts and features of 4th Dimension and 
4D Server.

The 4th Dimension User Reference provides a description of the User 
environment—the environment in which you use databases and layouts 
to enter and manipulate data.

The 4th Dimension Design Reference is a reference guide to the Design 
environment which provides detailed descriptions of the operations you 
can perform in this environment. You should use it in conjunction with 
the other volumes in your documentation package.

The 4th Dimension Language Reference is a guide to using the 4th Dimension 
language. Use this manual to learn how to customize a database by 

 

Ce document a été créé à l’aide de FrameMaker 4.0.4



PREFACE viii

incorporating 4th Dimension commands and functions.

The 4D Server Reference is a guide to installing and managing multi-user 
databases with 4D Server. This manual is included only in the 4D Server 
documentation package. 

The 4th Dimension Utilities Guide provides a guide to the utilities available 
with 4th Dimension and 4D Server, such as 4D Tools, and Customizer 
Plus.

The 4th Dimension Glossary and Master Index contains a glossary of terms 
and an index to all 4th Dimension manuals.

Additional important information is provided online. The electronic 
documentation is installed on your hard disk when you install 
4th Dimension.

ABOUT THIS TUTORIAL

This book offers you a series of tutorials, step-by-step explanations that 
teach you how to use many of 4th Dimension’s advanced features. Be sure 
to work through the whole book since later chapters assume knowledge 
of earlier chapters. 

The tutorials provide specific steps for you to follow, as well as general 
information that explains 4th Dimension. The steps are usually 
accompanied by a short comment or explanation. The format for steps 
and explanations looks like this:

1. A numbered step tells you exactly what to do. 

Following the numbered step is a separate paragraph that offers a 
pertinent explanation or comment.

When a numbered step asks you to type something, the characters you 
should type are enclosed in quotation marks:

2. Type “Garbondo” in the Last Name field.

Type exactly what is enclosed in the quotation marks, including any 
spaces or punctuation.

4D Server:  Unless otherwise noted, the tutorials work the same for 
4th Dimension and 4D Server. However, 4D Server users should be 
aware that conflicts may occur if two or more people work on the 
tutorials at the same time.
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Conventions
All the manuals in your documentation package, including this one, use 
certain conventions to help you understand the material. 

The following explanatory notes are used:

NOTE: Text emphasized like this provides annotations and shortcuts that will help you 
use 4th Dimension more productively.

4D Server:  Throughout the manual, 4th Dimension and 
4D Server/4D Client are referred to simply as 4th Dimension. 
Differences between the operation of the two products are 
explained in 4D Server notes which provide information about 
using 4D Server/4D Client. This information is provided only 
when the operation of 4D Server/4D Client differs from that of 
4th Dimension.

Notes like this alert you to important pieces of information.

Warnings like this alert you to situations where data might be lost.

In addition, all filenames are shown in brackets in the text to help 
distinguish them from the names of fields, layouts, and other items. For 
instance, the Companies file is written as the [Companies] file.
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Database: People01
Estimated time to complete: 25 minutes

In the 4th Dimension Quick Start manual you created a personnel database 
in which you used default layouts automatically created by 4th Dimension 
to enter and display employee data. In this chapter, you will learn how to 
create your own layouts and how to modify them using the Layout editor.

4th Dimension’s Layout editor includes a simple but powerful drawing 
program that allows you to make the screen design for your database 
exactly the way you want it. In addition, the Layout editor provides many 
additional functions that affect fields and how they work with 
information.

In this chapter you will learn how to:

■ Create layouts,

■ Select, move, and change elements on a layout,

■ Change text on a layout,

■ Draw lines and shapes,

■ Use fill patterns,

■ Set the display format for numbers and dates.

USING THE LAYOUT EDITOR 1
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CREATING AN INPUT LAYOUT

In this section, you will create an input layout for entering employee data 
into your personnel database. Later on, you will modify this layout to 
improve data entry and create an effective user interface.

1. If you have not done so already, start 4th Dimension and open the 
People01 database.

The tutorials databases are located in the Tutorials directory in the 
4th Dimension directory.

People01 starts in the Design environment.

2. Choose Layout... from the Design menu.

4th Dimension displays the Layout dialog box which you will use to create 
your input layout.

The List of Files displays the names of all files in the database. Since there 
is only one file in the database, [Employees], only one filename is 
displayed. After you create a layout, the layout name will be displayed 
beneath the [Employees] filename.

The [Employees] filename should be highlighted. If it is not highlighted, 
select it. 

You are now ready to create a layout for this file.

Filename

List of Files
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3. Click the New button.

4th Dimension displays the New Layout dialog box.

The New Layout dialog box is where you name the layout, choose the 
fields that you want to include, and specify the font size and layout 
template you want to use. A layout template is a pattern 4th Dimension 
uses to create a layout. 

The layout templates have been designed to display information 
effectively. 4th Dimension provides three output layout templates for 
listing information in a row-and-column format and five input layout 
templates for displaying one record at a time. You will usually start with 
one of these templates for your layout and then modify the layout to suit 
your needs exactly. If you wanted to design an original layout yourself, 
you would choose Custom from the group of templates.

4th Dimension automatically places all the fields in the layout unless you 
select specific fields you want to use. Since you will use all the fields for 
your input layout, you do not need to select any fields. Later in this 
chapter you will learn how to use the New Layout dialog box to select 
only the fields you want and place them in the order you want them.

For this layout, you will use layout template #4, which is already selected.

4. Type “Employee Input” as the name of the layout you are creating.

The Layout Name text box is preselected when the dialog box opens so 
that you can type the layout name immediately.

5. Click OK.

4th Dimension creates the layout and displays it in the Layout editor. The 
Layout editor allows you to modify any layout. You can modify a layout 
immediately after you create it or at a later time. 

Output layout templates

Input layout templates

Field List
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Your layout includes all the fields, displayed in the order they were 
created.

6. Click the maximize button so that the Layout window fills the entire 
screen.

The maximize button is in the upper right corner of the Layout window.

You have just created your own input layout. Your input layout is ideally 
suited to enter information. Records appear on the screen one at a time. 
When you have entered the information in the fields for one record, you 
go on to the next record.

You can leave this window open while you continue the tutorial. 
4th Dimension allows you to open as many windows as you want, limited 
only by the memory available on your machine.

In the next section, you will create an output layout that displays several 
records at a time in a list format.

Maximize button
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CREATING AN OUTPUT LAYOUT

To view as much information at one time as possible, you need a display 
that lists records in rows and columns. A list layout lets you display and 
print many records.

To create a second layout, you use the Layout dialog box and the New 
Layout dialog box again. 

1. Choose Layout... from the Design menu.

4th Dimension displays the Layout dialog box. The [Employees] filename 
is highlighted.

2. Click the New button in the Layout dialog box.

4th Dimension displays the New Layout dialog box.

3. Enter “Employee List” as the layout name.

4. Select the first layout template (in the upper left corner of the 
template choices) and make the font size 9-point.

The first three standard layout templates are for output layouts. They 
display the records in rows and columns. The first template, the one you 
have chosen, shows the field names at the top of the columns.

For your output layout, you want the employees’ first names to appear in 
the first column instead of the second column. You need to select the 
fields manually to place them in a different order on the layout.

5. Select First Name in the fields list and click the Select button.

4th Dimension places a number 1 next to First Name. The number 
indicates the selection order for the field.

6. Select Last Name and click the Select button.

4th Dimension places a number 2 next to Last Name.

NOTE: As a shortcut, you can double-click a field to select it.
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7. Double-click Start Day.

Double-clicking selects the field for the layout.

8. Select Salary and Title.

You can either use the Select button or double-click the field names to 
select them.

9. Click OK.

4th Dimension creates the output layout for you.

10. Drag the window to expand it so that you can see how the layout is 
designed.

Dragging the windows is an alternative to using the maximize button.

This layout shows all the fields for a single record. The fields are placed 
below the field labels. When this layout is used, it will automatically 
generate a row-and-column listing of records with a field label at the top 
of each column.

11. Minimize the layout windows by clicking the minimize button in the 
upper right corners of the windows.
OR
Double-click the Control-menu box of each layout window to close the 
windows.

Field labels
Fields
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4th Dimension automatically saves the layouts and returns to the 
Structure window.

You can use the Layout editor to create many different layouts. However, 
when you are entering and managing information in the User 
environment, you will always use one input layout and one output 
layout. 4th Dimension displays the input layout when you enter or modify 
information. It displays the output layout when you want to display the 
records as a list. 

MODIFYING THE LAYOUT

Once you create a layout, you may want to modify it using the tools in 
the Layout editor. These tools give you complete control over the 
appearance of your screens and printed reports.

1. Choose Layout... from the Design menu.

4th Dimension opens the Layout dialog box. You can open any layout 
from this dialog box.

2. Click the Expand button to show the [Employees] file layouts.

Notice that there are two other layouts in addition to the layouts you just 
created. The input and output layouts listed first under the [Employees] 
file are the default layouts 4th Dimension automatically created for the 
file. The Employee Input and Employee List layouts listed below them are 
the layouts you created.

Filename

Layout names
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3. Select the Employee Input layout and click the Open button. 
OR
Double-click the Employee Input layout name.

4th Dimension displays the layout in its own window.

4. Expand the window by clicking the maximize button or by dragging 
the window so that the layout window fills the entire screen.

The Layout editor is similar to a Windows drawing program. You can 
change the background patterns and line widths, enter descriptive text, 
and change the style and font of the typeface. The layout palette and the 
Layout editor menus allow you to create exactly the layout you want to 
use. And, if you make a mistake, you can simply choose Undo from the 
Edit menu and your last action is undone. You can also use the other 
menu commands in the Edit menu to perform standard Windows cut and 
paste operations in your layout.

Notice that this layout has been given a title that is the same as the 
filename, “Employees.” Because this particular layout will be used to enter 
and modify information for each employee, you decide to change the title 
to “Employee Information.”

Each element on the layout is an object that you select in order to change 
it. You can move the object simply by selecting it and dragging it to its 
new location. You use the handles that appear on the boundary of an 
object (an invisible rectangle enclosing the object) to change the size of 
the object.

5. Make sure you click the Arrow tool  if it is not already selected.

The Arrow tool allows you to select objects on the layout. In the next step 
you are going to select the layout title.

Layout tool 
palette
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6. Click once on the title Employees.

Be sure to click on the word itself.

4th Dimension displays handles around the title.

The title area is a graphic object. When it is selected, handles appear on 
each corner of the boundary. In the next step, you will use one of the 
handles to resize the title area.

If you wish, select different objects in the layout area. You will see that the 
handles always show the selected object. Be sure to select the title again 
before going on to the next step.

7. Drag the title area to the left, placing it just within the border of the 
layout.

When you start to move the title area, it becomes a blank rectangle.

Arrow tool
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8. Resize the title area by making it as wide as the border of the layout.

You resize an object by placing the tip of the pointer on one of the 
handles so that the pointer changes into a multi-directional arrow . 
You then drag the handle to resize the object.

Feel free to resize several of the objects on the screen. You can always 
return to the original layout by choosing Revert to Saved from the File 
menu. At any point, you can go back one step by choosing Undo from 
the Edit menu. Be sure to leave your screen looking like the previous 
illustration before continuing.

9. Select the Text Area tool  from the layout palette.

10. Drag the I-beam pointer across the entire title.

You are going to replace the title with “Employee Information”.

11. Type “Employee Information”.

The new title replaces the old one.

Text Area tool



USING THE LAYOUT EDITOR

USING THE LAYOUT EDITOR 1

1-11

NOTE: The layout title has nothing to do with the layout name; the title is strictly a text 
element added to the layout. If you refer to this layout in procedures, you will use 
Employee Input, the name you gave this particular layout.

12. Choose Center from the Style menu to center the new title.

Your final screen should look like this:

13. To prepare for the next steps, click the Arrow tool.

The pointer changes to an arrow.

Using the Layout Editor Drawing Tools
The 4th Dimension Layout editor has graphic design features that allow 
you to create borders, lines, and patterns to enhance your layout. Objects 
can be layered, that is, placed on top of or beneath other objects. Any 
object on the layout can be moved backward or forward so that it appears 
beneath or on top of other objects.

In this section, you will explore some of the Layout editor’s graphic 
capabilities.

1. Choose Save Layout: Employee Input from the File menu.

It is always a good idea to save a layout you are happy with so that if you 
do not like the changes you make, you can return to the previous version 
of the layout.

2. Click within the border of the layout (but not on another object) so 
that the border is selected.

Handles appear at the corners of the layout border.

In the next step, you will choose a fill pattern for the layout from a 
cascading menu. Choosing from a cascading menu is a two-step process.



USING THE LAYOUT EDITOR 1-12

3. Choose Fill... from the Object menu.

The Fill Pattern cascading menu appears next to the Object menu.

4. While holding down the mouse button, drag the pointer to the pattern 
you want to use and then release the mouse button.

4th Dimension displays the border rectangle with the fill pattern you have 
chosen. As you see on your screen, the title, field labels, and fields are not 
obscured by the fill pattern. This is because they are in front of the 
background and the border.

In the next step, you will choose a new line width for the border from 
another cascading menu. Make sure that the border is still selected before 
you go on.

5. Choose Line Width from the Object menu and select the widest line 
width from the Line Width cascading menu.

4th Dimension displays the background with the new line width.

In the next steps, you will draw some shapes and experiment with the 

Handles indicate that 
the border is selected

Fill pattern 
cascading menu
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Move to Front and Move to Back tools.

6. Click the Oval tool   in the layout palette and draw an oval below 
the border of the layout.

The screen scrolls to make room for the oval if you draw below the bottom 
of the window.

7. Choose a new fill pattern from the Fill... cascading menu.

8. Drag the oval onto the layout.

The oval covers whatever is beneath it.

9. Click the Move to Back tool  to move the oval beneath the layout.

Feel free to use the other drawing tools to draw any lines, rectangles, or 
rounded rectangles you wish. You can drag them to different locations 
and resize them into different shapes. This kind of experimentation can 
spark ideas for how to use the different shapes to create interesting and 
useful layout designs.

10. When you are finished, choose Revert to Saved from the File menu. 

11. Click the Yes button to confirm that you want to revert to the last 
saved version of the layout.

The layout you have been working on is replaced by the version you saved 
at the beginning of this section.

Move to Back tool

Oval is behind
the background
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Using the Alignment Tools
When you modify a layout by moving, adding, or rearranging layout 
elements, you often want to align objects in relation to one another. 
4th Dimension provides alignment tools that allow you to align selected 
objects precisely.

In this section, you will explore the effects of the alignment tools.

1. Use the Rectangle tool  to create a rectangle below the current 
layout border and fill the rectangle with a pattern. 

2. Deselect the rectangle by clicking somewhere outside of the layout.

You will use this rectangle to see how the alignment tools function.

3. Hold down the Shift key while you click each of the fields on your 
layout.

Be sure to select just the fields, not the field labels.

Shift-clicking is one way to select more than one object at a time.

4. Drag the selected fields into the new rectangle. 

When you drag any one field, the others follow along. 

5. Click the Move to Front icon  to place the fields on top of the 
rectangle.

Dragging the fields off the layout background leaves boxes that were 
automatically placed beneath the fields by 4th Dimension. These boxes are 
the blank field spaces on the data entry screen.

6. Leaving the fields selected, click the Align Right icon .

The right edges of the fields are vertically aligned.

Boxes behind the 
fields remain

Handles show all 
fields are selected
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7. Click the Align Center Vertical icon .

The centers of the fields are vertically aligned.

You have been using the vertical alignment tools because the objects you 
are aligning are arranged vertically. If you use any of the horizontal 
alignment tools, the fields will be aligned but you will be able to see only 
one of them because they will be aligned to the same horizontal location. 
If you inadvertently use a horizontal alignment tool, drag the fields off 
the stack one at a time or choose Undo from the File menu.

8. Shift+click, as in step 3, to add the rectangle to your selection and 
then experiment with the alignment tools.

4th Dimension aligns the fields and the rectangle.

9. When you are finished, choose Revert to Saved from the File menu to 
restore the Layout. 

10. Click the Yes button.

Alignment tools
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Setting Display Formats
4th Dimension allows you to set the display format for data. The display 
format determines how the entries in each field are displayed on your 
screen and printed.

You set the display format using the Layout editor. Each layout can use a 
different format for the same information. On one layout you may want 
numbers to be displayed in one of these formats:

■ 1234.567,

■ 1,234.57,

■ $1,234.57.

On another layout you might want the format to include dollar signs, 
commas, and a row of asterisks for printing the number on a check:

$**********1,234.57

Display formats are separate from the data you enter in the fields. 
The display format does not affect the way you enter the information or 
the way the information is stored—only the way it is displayed.

For the Employee Input layout, you will set the display formats for the 
Start Day and Salary fields. For our example database, you have decided 
to show the start date in this format: 

Sat, June 13, 1992

For the Salary field, you want a dollar sign, a comma, and two digits to the 
right of the decimal: 

$35,550.00
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To set the display formats, follow these steps:

1. Select the Start Day field.

You can select the field by clicking on it. Be sure to select the field (not the 
field label). The field has a box around it; the field label is a text element 
without a box.

2. Choose Format... from the Object menu.

4th Dimension displays the Field Definition dialog box.

The Field Definition dialog box allows you to set the display format and 
control other aspects of data entry and display. You will find an 
introduction to the advanced features of this dialog box in later chapters. 
For now, we will use only the boxes in the upper portion of the panel.

Handles on
selected object

Format drop-down 

Format Display area

list box
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The fields in the file are listed in the Field area on the left. The Start Day 
field is highlighted and the date format choices appear in a drop-down list 
box on the right. You set the format for the field by choosing it from the 
drop-down list box. The current format for the Start Day field is shown in 
the list box.

Drop-down list boxes are indicated by a drop shadow below the box. You 
choose from a drop-down list box just as you do from any menu. The only 
difference is that the menu appears on the screen, not on the menu bar

3. Choose Abbreviated from the Format drop-down list box.

The Abbreviated choice displays the date in the Sat, Jun 13, 1992 format. 
The Long format would show it as Saturday, June 13, 1992. The Short 
format would show it as 6/13/92.

4. Click OK.

4th Dimension displays the layout again. Although the layout appears the 
same, 4th Dimension has accepted your instruction for displaying the 
Start Day. When you use this layout, the start date will be displayed in the 
format you have chosen.

Since the Abbreviated date format displays more characters than the Short 
date format, the date field needs to be enlarged to accommodate the 
display format you have chosen.
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5. Select the Start Day field (not the field label) and drag the handle on 
the lower right corner to the right to make the field longer. 

Notice that the border around the field remains in the same position as 
before. You need to drag the border around the field to the same position 
as the field so that the date box displays correctly during data entry.

6. Select the border around the field and drag the handle on the lower 
right corner to the right to match the size of the field.

You are now ready to set the display format for salaries.

7. Double-click on the Salary field.

Double-clicking is a shortcut to display the Field Definition dialog box. 
4th Dimension displays the dialog box again, this time highlighting the 
Salary field.

8. Hold down the mouse button on the Format drop-down list box to see 
the format choices.

You can set the display format by selecting it from the choices shown by 
selecting and modifying it, or by entering the format, character by 
character, in the Format Display area.

The formal structure of the number display format has three parts—the 
first is for positive numbers, the second is for negative numbers, and the 
third is for the number zero.
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9. Choose $###,##0.00;-$###,##0.00 from the Format drop-down list 
box.

4th Dimension displays the format in the Format Display area. The 
number signs show that you can display up to six digits. The zeros show 
that 4th Dimension automatically displays two digits after the decimal 
point. If no digits are entered, 4th Dimension displays two zeros after the 
decimal point. A negative number is preceded by a minus sign and there 
is no special format for zero.

10. Click OK.

4th Dimension displays the layout. You have now established the display 
format for the Salary field.
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SEEING THE LAYOUT IN ACTION

You can go directly to the User environment to see the results of your 
changes.

1. Choose User from the Use menu.

4th Dimension automatically saves your layout, including the display 
formats you have selected, and displays the [Employees] file records using 
the default output layout Output.

To see how the input and output layouts you created work, you must first 
make them the default layouts for the [Employees] file.

2. Choose Choose File/Layout... from the File menu.

The Choose File/Layout dialog box appears with the [Employees] file 
selected.

3. Click the Expand button to display the layouts for the [Employees] 
file.

4. Select Employee Input and then select the Input check box.

Employee Input is now the default input layout for the [Employees] file. 
Whenever you add, modify, or view a record in this file, the Employee 
Input layout will be used.

5. Select Employee List and then select the Output check box.

Employee List is now the default output layout for the [Employees] file. 
Whenever the records in the file are displayed in a list, this layout will be 
used.
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6. Click the Done button to return to the output layout.

7. Select any record and choose Modify Record from the Enter menu.

The record appears on the input layout you have been working with. 
Notice that the layout title has been changed and the Start Day and Salary 
fields are displayed in the formats you selected.

THE NEXT STEP

You often modify layouts in 4th Dimension when you add fields, 
rearrange layout elements, or design a custom layout. The palette tools 
provide the power to make any layout clear, attractive, and useful.

If you wish, you can change the display format for Salary on your output 
layout as well. You can use the same format as the one on the input layout 
or you can use a different one.

In the next chapter, you will learn how to add custom buttons to the 
layout. 

If you wish to take a break now, you can choose Quit from the File menu 
to quit 4th Dimension. In the next chapter, you will run 4th Dimension 
and open the People02 database.
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Database: People02
Estimated time to complete: 15 minutes

4th Dimension provides more than a dozen automatic buttons that you 
can use to perform functions such as accepting a record, displaying the 
first record, going to the next page in a multi-page layout, and deleting 
the current record.

In this chapter you will learn how to:

■ Create buttons on a layout,

■ Use your custom buttons to save, cancel, and move between records.

Up to now, when you entered or modified a record, you used 
4th Dimension’s control panel to accept, cancel, and move from record to 
record. 

Your custom buttons will automatically replace the control panel. When 
you have finished with this tutorial, your data entry screen will look like 
this:

In this tutorial, you will add four buttons to your layout: OK, Cancel, 
Next Record, and Previous Record. A button is one of several special 
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Windows features you can include on your layouts. Other objects you can 
include are check boxes, graph areas, rulers, dials, thermometers, and 
scrollable areas from which you can select items in a list.

CREATING AN OK BUTTON

You are now going to replace the Enter and Cancel buttons provided by 
the control panel with your own custom buttons. In this section, you will 
create an OK button.

1. If you have not done so already, start 4th Dimension and open the 
People02 database. 
OR
If you are already in 4th Dimension, choose Open Database from the File 
menu and open the People02 database.

People02 starts in the Design environment.

2. Double-click the [Employees] filename.

4th Dimension displays the Layout dialog box. Double-clicking a filename 
in the Structure window is a shortcut that opens the Layout dialog box 
with the file already expanded to show the layouts for that file.

3. Open the Buttons layout.

4. Click the maximize button or drag the window to expand it to fill the 
entire screen.

You are going to position the buttons below the border so that the buttons 
are separate from the portion of the layout that contains the fields.

5. Click the Active Object icon  on the layout palette.

Clicking this icon informs 4th Dimension that the next area you define on 
the layout will contain an active object.
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6. Draw a rectangle about 1 inch long and 1/2 inch high below the frame.

The rectangle should be aligned with the left edge of the data entry 
border.

When you release the mouse button, 4th Dimension displays the Object 
Definition dialog box. The Object Definition dialog box is similar to the 
Field Definition dialog box you used in Chapter 1.

An active object can perform many actions, from displaying data to 
working as a button or drop-down list box. You are going to use this active 
object as a button.

Object Type drop-down 
list box

Object Action
drop-down list box
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7. Choose Button from the Object Type drop-down list box.

There are 15 types of layout objects to choose from in the Object Type 
drop-down list box. For complete information about these choices, refer 
to the 4th Dimension Design Reference.

8. Name the button “bOK” and press Tab. 

Notice that the Text area is selected and has been given a new title, Button 
text. This is the area in which you will type the text that you want 
displayed in your button.

9. Label the button “OK”.

You can type any text that conveys the message you want, such as Enter, 
Accept Record, and so on.

10. Choose Accept from the Object Action drop-down list box located 
below the Object Type drop-down list box.

Just as Button is one type of object, the choices in the Object Action 
drop-down list box are different actions that you can assign to a button. 
You will choose four actions for buttons in this tutorial. For complete 
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information about these actions, refer to the 4th Dimension Design 
Reference.

4th Dimension displays Accept as the action. The button you are defining 
will cause a record to be accepted when it is clicked.

11. Click OK.

4th Dimension displays the layout again, this time with your button on it. 

You have added the first of your buttons to the layout. In the next section, 
you will create additional buttons the same size as this one.
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DUPLICATING AND EDITING BUTTONS

For your screen design, you want all your new buttons to be the same size. 
The easiest way to accomplish this is to duplicate the button you just 
created and then edit the definition of each of the copies.

Remember, you are adding OK, Cancel, Next Record, and Previous 
Record buttons to your layout. You have already added OK, so you need 
three more buttons.

1. If necessary, click the OK button you just created to select it and then 
click the Duplicate icon .

4th Dimension creates a copy of the OK button. The copy has all the 
instructions you specified for the first OK button. When 4th Dimension 
duplicates a layout element, all the instructions for the element are 
copied as well (for example, a field’s display format is copied).

2. Drag the new button to the right of the first button.

When you position this button and keep it selected, you prepare to use 
4th Dimension’s smart duplicate feature. When you use this feature, 
4th Dimension remembers where you positioned the button in relation to 
the first button and automatically places the next copy in the same 
position relative to the selected object.

3. Click the Duplicate icon two more times.

4th Dimension creates two more buttons, each placed to the right of the 
previous copy. If for some reason the duplication does not place the new 
button to the right of its original, you may have inadvertently selected 
something else before duplicating. In this case, delete any copies you have 
made and start over again at step 1.

Duplicate of
OK button
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4. To align the four buttons exactly, Shift+click all four to select them as 
a group and then click the Align Top icon .

4th Dimension aligns the buttons in relation to each other.

If you make a mistake, don’t forget that you can go back a step by 
choosing Undo from the Edit menu.

5. Click anywhere other than the four selected buttons.

The four buttons are deselected.

6. Double-click the second button.

Double-clicking the button displays the Object Definition dialog box for 
that button. You are going to make this button the Cancel button. The 
instructions in the dialog box are the ones you entered for the OK button. 
To make this button the Cancel button, all you need to do is choose 
Cancel for the action and change the button’s name and display text.

7. Name the button “bCancel” and label it “Cancel”.

8. Choose Cancel from the Action drop-down list box and click OK.

4th Dimension displays the layout again. Notice that the second button is 
now a Cancel button.

9. Make the third button a Next Record button by double-clicking it, 
changing the button name to “bNext”, the button action to Next Record, 
and the button text to “Next”.

10. Make the fourth button a Previous Record button by double-clicking 
it, changing the button name to “bPrevious”, the button action to 
Previous Record, and the button text to “Previous”.

Your layout is finished. It now includes the set of custom buttons you 
have created.
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SEEING THE CUSTOM BUTTONS IN ACTION

As you learned in the previous chapter, you can go to the User 
environment to check on work you have done in the Design 
environment.

Since 4th Dimension removes the standard control panel when you create 
your own buttons, you want to see how the new buttons affect the 
appearance and functionality of your layout.

Marlys Wilson has been promoted in the Art Department. Her new title is 
Supervisor and her new salary is $36,500. You are going to use your new 
layout to modify her employee record.

1. Choose User from the Use menu.

4th Dimension displays the records in the List layout.

2. Select the record for Marlys Wilson and choose Modify Record from 
the Enter menu.

4th Dimension displays your previous input layout. Because you have 
created another input layout, you need to tell 4th Dimension to use the 
new layout instead.

Here is a new method for changing the input layout. It is usually much 
faster than using the Choose File/Layout dialog box.

3. Press Ctrl+Space bar.

The List of files window is displayed in front of the Employee records 
window. The List of Files window is always open, waiting behind the 
window you are using. If you make the Employee records window smaller, 
you can see the List of Files window and can activate it by clicking on it.

The layout icons are drop-down menus showing the layouts you have 
created for the file. You use the Input Layout icon to set a new input 
layout for that file and you use the Output Layout icon to set a new 
output layout for that file.

Input layout icon

Output layout icon

Filename
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4. Click and hold down the mouse button on the Input layout icon and 
choose Buttons from the drop-down menu.

4th Dimension displays the Buttons layout, ready for you to enter 
information.

Notice that 4th Dimension has removed the standard control panel from 
the left side of the screen. Your custom buttons are now arranged across 
the bottom of the screen.

5. Press Ctrl+Space bar to hide the List of Files window.

6. Enter the new information for Marlys Wilson:

Salary:“36500”

Title:“Supervisor”

7. Click the Next button.

4th Dimension saves the new information for Marlys Wilson and displays 
the next record in the database.
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8. Click the Previous button.

4th Dimension displays the record you just modified. You can use 
Previous and Next to move from record to record as often as you wish.

9. Click OK.

4th Dimension returns to the output layout for this database.

THE NEXT STEP

You have added buttons to your layout that allow you to accept and store 
the information on the current record or to cancel the information that 
has been entered or modified. The other buttons you added allow you to 
navigate through the records in your database by moving to the next or 
previous record.

In the next chapter you will work more in the Layout editor. You will add 
a new page to a layout and then change the data entry order.



3-1CUSTOMIZING A MULTI-PAGE LAYOUT

Database: People03
Estimated time to complete: 20 minutes

4th Dimension allows you to control virtually everything about your 
layouts. For example, if you have too many fields to conveniently display 
on one screen, you can add additional pages. 

During data entry, when you use the Tab key to move from field to field, 
4th Dimension automatically selects the next field according to the data 
entry order. If this order is not convenient for entering data on your 
layout, you can change the data entry order to fit your needs.

In this chapter you will learn how to:

■ Add a page to your layout to make it a multi-page layout,

■ Change the data entry order.

CUSTOMIZING A MULTI-PAGE LAYOUT 3
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SINGLE-PAGE AND MULTI-PAGE LAYOUTS

4th Dimension’s layouts provide a large “page” on which to place fields 
and active and graphic objects such as buttons and text. A single-page 
layout can be as much as 144 inches wide and 142 inches high (almost 
144 square feet). To move around the layout in the Layout editor, you use 
the scroll bars.

You may want to divide a large layout into two or more separate pages. 
4th Dimension calls such a layout a multi-page layout. 

When you use a multi-page layout, you can do the following:

■ Reduce the amount of scrolling necessary to work with a layout,

■ Create a more attractive layout,

■ Group related fields together on a particular page so you can quickly 
update related information (for example, placing all the fields that need 
regular modification on the first page of a layout),

■ Design each page of the layout to fit the size of the display monitor 
used by your system,

■ Replicate your company’s current multi-page forms.

Many standard forms, such as employment applications, contracts for 
real estate, and insurance forms, consist of several pages. Just like turning 
to the appropriate page in a multi-page paper form, when you use a 
multi-page layout, you can display the page that contains the 
information you want to view or change.

Adding a Page
Suppose you have been working with another layout for the People 
database, one that keeps track of emergency information for each 
employee. The layout you are now using takes up more than the entire 
screen. You decide to add a page to the layout so you can more 
conveniently display the information. Two pages allow you to create a 
more attractive display for the information and reduce the amount of 
scrolling you have to do during data entry.

You plan to place official information on the first page (name, salary, 
department, and so on) and personal information on the second page 
(address, spouse’s name, doctor’s name, and telephone).

In this section, you will learn how to add a page, how to choose the parts 
of the layout you want to display on the new page, and how to transfer 



CUSTOMIZING A MULTI-PAGE LAYOUT

CUSTOMIZING A MULTI-PAGE LAYOUT 3

3-3

them to the new page.

1. If you have not done so already, start 4th Dimension and open the 
People03 database.

People03 starts in the Design environment.

2. Display the Emerg Records layout by double-clicking the 
[Employees] filename and then double-clicking the Emerg Records 
layout.

3. If necessary, click the maximize button to expand the window.

Expanding the window reveals all the icons.

4. Add a page to the layout by clicking the Next Page icon .

Since there is no next page, 4th Dimension asks if you want to create one.

5. Click OK.

4th Dimension creates a blank page. The number of the page and the total 
number of pages is displayed in the bottom right corner of the layout.

You can now select the fields you want to place on the second page.

Page number
Total number of 
layout pages
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Adding Fields to the Layout
4th Dimension provides a way to go back to the New Layout dialog box so 
that you can add fields to an existing layout. To add the personal fields to 
the new second page:

1. Choose Add to Layout... from the Layout menu.

The pointer changes to a corner marker .

2. Click near the upper left corner of the screen.

This spot marks the upper left corner of the layout that will appear. When 
you release the mouse button, 4th Dimension displays the New Layout 
dialog box.

3. Double-click the following fields: Spouse, Address, City, State, Zip 
Code, Phone, Doctor, and Emergency Phone. 
OR
Select each field and click the Select button.

Layout #4 is already selected for you so you need only change the font 
size.

4. Select the 9-point font size and click OK.

4th Dimension adds the fields you selected to the second page of your 
layout.

Layout page 
number
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Adding Next Page and Previous Page Buttons
You have created a second page and placed the elements you want on it. 
Now you need to add buttons that allow you to move between the two 
pages.

1. Go back to the first page of your layout by clicking the Previous Page 
icon .

2. Use the Active Object icon  to add a Next Page button to the first 
page of your layout.

The Object Definition dialog box appears.

3. Name the button “bNext”, choose Button from the Object Type drop-
down list box, choose Next Page from the Object Action drop-down list 
box, and enter “Next Page” for the button text.

4. Click OK.

The layout should now look like this:

5. Copy the button by selecting it and choosing Copy from the Edit 
menu.

6. Go to the second page and paste the copied button by choosing 
Paste from the Edit menu.

7. Drag the button to any position on the layout and click anywhere 
outside the button to deselect it.

8. Change the name of the copied button to bPrevious, the action to 
Previous Page, and the button text to “Previous Page”.

NOTE: You should give each button in your database a unique name. For example, if you 
have both Previous Record and Previous Page buttons on a layout, be sure to give them 
different names.

Next page button 
added to the layout
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Your new layout is complete.

Seeing the Multi-Page Layout in Action
Now that you have created a multi-page layout, you can see how it works.

1. Go to the User environment and change the input layout to Emerg 
Records in order to see your multi-page layout. 

Changing the layout is described in Chapter 2.

2. Add a new record. 

Use the Next Page and Previous Page buttons to move between the two 
pages of your single layout. Switch to the Design environment when you 
are finished.

DATA ENTRY ORDER

You may have noticed that 4th Dimension automatically selects the fields 
on your layout as you use the Tab key to move from one field to the next. 
The order in which the fields are selected, the data entry order, is 
determined automatically by 4th Dimension. To change this order, you 
use the Layout editor.

The default data entry order 4th Dimension uses is based strictly on the 
position of the fields on a layout. The order proceeds from left to right and 
from top to bottom. If one field is above another, it is selected first; if one 
field is to the left of another, it is selected first. Precedence is given to a 
field if it is even one pixel (one dot) above another field.

The leftmost field 
is selected first

The topmost field is 
selected first
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Changing the data entry order allows you to do the following:

■ Select fields in a logical order,

■ Select fields in the order the information is presented for data entry (for 
example, a form that a customer fills out may display information in a 
different order from the fields on the screen),

■ Place fields that are rarely updated last so they can be easily skipped.

Changing the Data Entry Order
In this section, you will use a layout that displays the information 
conveniently but has an awkward data entry order. You will then change 
the data entry order to make data entry easier.

1. Choose Layout... from the Design menu and open the Side By Side 
layout.

4th Dimension displays the layout in another Layout editor window.

2. If necessary, click the maximize button to expand the window.

As you can see, this layout provides an attractive visual display of fields, 
exactly like the paper form used by your employees. Unfortunately, the 
data entry order makes it difficult to enter information.
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3. Choose Entry Order... from the Layout menu.

4th Dimension displays the data entry order and the pointer changes to a 
small arrow . The data entry order is indicated by arrows that point 
from field to field. 

As you can see, the order goes across the screen before going down. 
Ideally, you want to enter information into the fields on the left first, then 
into the fields on the right.

The selection order arrows extend from the middle of one field to the 
middle of the next. You change the order by drawing new selection order 
arrows from one field to another.

Here is the order you want to have:
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4. Move the pointer to the Last Name field on the left side and drag the 
pointer to the First Name field.

When you release the mouse button, 4th Dimension redraws the selection 
order arrows for all affected fields.

You could continue in this fashion, drawing the new data entry order 
from field to field. However, 4th Dimension provides a way to quickly 
change whole groups of fields.

5. Drag a marquee around the group of fields on the left.

You create a marquee by clicking in an empty area on the layout and 
dragging to enclose the group of objects you want to select.

When you release the mouse button, 4th Dimension automatically 
redraws the data entry order. The order goes down the left group first, 
then up to the right group and down again.

Marquee
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6. Click the Pointer tool  to return to normal layout editing.

7. Try out your new custom data entry order in the User environment.

Remember that you have to change the current input layout to 
“Side By Side” to use your new data entry order.

THE NEXT STEP

The Layout editor is a flexible design tool. You can create layouts that 
assist the data entry process, display information effectively, and look 
attractive.

Practice using the Layout editor to learn more about what you can do 
with lines, shapes, and fill patterns. You can find complete information 
about the tools available in the Layout editor in the 4th Dimension Design 
Reference.

In the next chapter you will add a field to the People database and to a 
layout. You will then use the Lists editor to create a list from which you 
can select an entry for the field.



4-1ADDING FIELDS AND LISTS

Database: People04
Estimated time to complete: 20 minutes

You can add new fields to a 4th Dimension file at any time. You add a field 
to a database when you discover that you need to store an additional piece 
of information about each record.

You already learned how to create a field in the 4th Dimension Quick Start 
manual. Adding a field is essentially the same process, except that you 
must remember to place it on any existing layouts in order to enter and 
view the data. 

Instead of having users enter information into the field manually, you 
may decide to create a list of entries from which users can choose items. 
The list is displayed during data entry, allowing users to choose an entry 
from the list. Choosing from a list simplifies data entry and ensures that 
the entry is valid, spelled correctly, and contains no extra spaces or other 
punctuation errors.

You can have multiple lists in a database and can use the lists for several 
fields and enterable objects. You can make a list mandatory so that only 
entries appearing on the list can be entered. Or, you can make a list 
excluded so that entries appearing on the list cannot be entered.

In this chapter you will learn how to: 

■ Create a list,

■ Add a field to a database,

■ Place a field on a layout,

■ Attach a list to a field,

■ Use the list for data entry.
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CREATING A LIST

Your company offers several health plans for its employees. You have 
decided to keep track of which health plan each employee has selected. 
In this section, you will make a list of the plan names. This list will 
provide data entry choices for the new field you plan to add to the 
database.

1. If you have not already done so, start 4th Dimension and open the 
People04 database.

People04 opens in the Design environment.

2. Choose Lists... from the Design menu.

4th Dimension displays the List editor.

The names of the lists you create appear in the Lists area and the choices 
on each list appear in the Items area.

3. Choose New from the Lists menu.

4th Dimension displays a dotted-line box in the Lists area.

4. Type “Health Plans”.

Health Plans is the name of this choice list. You will use this name 
whenever you want to activate this list.

Having created the list, you now will add items to it.

5. Choose New from the Items menu.

4th Dimension displays a dotted-line box in the Items area.

6. Type “White Cross”.

White Cross is one of the health plans an employee can join.

7. Choose New from the Items menu.

4th Dimension adds the first item to the Items list and displays a second 
dotted-line box.
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8. Type “King HMO” and press the Enter key.

4th Dimension adds the second item to the Items list and displays another 
dotted-line box. Pressing the Enter key is a shortcut for choosing New 
from the Items menu.

9. Complete the list by entering the following choices:

“Green Shield”

“National”

“None”

10. Choose Sort from the Items menu to arrange the choices in 
alphabetical order.

4th Dimension sorts the titles.

When you create a list, 4th Dimension assumes you want to be able to 
modify the list during data entry. Since your company might add a new 
health plan in the future, you decide to allow the list to be modified.

11. Pull down the Lists menu to ensure that User Modifiable has a check 
mark. 

The check mark indicates that the list is modifiable. If the check mark 
does not appear next to User Modifiable, choose User Modifiable.

12. Double-click the Control-menu box to close the List editor.

That is all there is to creating a choice list. In the following sections, you 
will see how to attach this list to a field and how to use it during data 
entry.



ADDING FIELDS AND LISTS 4-4

ADDING A NEW FIELD

You have created a list that offers health plan choices. In this section you 
will add a field and attach the list to it so that the list appears during data 
entry.

1. If necessary, choose Structure from the Design menu to view the 
Structure window.

2. Double-click beneath the last field of the [Employees] file.

Double-clicking is a shortcut for choosing New Field from the Structure 
menu. 4th Dimension displays the Field Attributes dialog box, ready for 
you to add a new field to the file.

If you accidentally click one of the existing fields in the file, 
4th Dimension displays the Field Attributes dialog box for that field. If this 
happens, click the Cancel button and try again.

3. Create a field called “Health Plan” and use the default field type and 
size, Alpha 20.

As you did in the 4th Dimension Quick Start, type the field name in the Field 
Name text box.

4. Click the Choices check box.

When you select Choices, the List button becomes active.

5. Click the List button.

4th Dimension displays the Lists dialog box. This dialog box displays all 
the lists that have been created for this database. Since you have created 
only the Health Plans list, it is the only one displayed.

6. With the Health Plans list highlighted, click the Select button.

4th Dimension displays the Field Attributes dialog box. Whenever you 
select this field during data entry, the Health Plans list will appear so that 
you can select that employee’s plan.
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7. Click OK.

4th Dimension displays the Structure window. You have successfully 
added the Health Plan field to the file. However, the new field does not 
yet appear on any layout. You need to add it to an existing layout to be 
able to enter and view data in the field.

PLACING THE NEW FIELD ON A LAYOUT

Now that your new field exists, the next step is to add this field to a layout. 
To do this, you use the Layout editor.

1. Double-click the title bar of the [Employees] file.

Double-clicking the file’s title bar in the Structure window tells 
4th Dimension that you want to see a layout for that file. When 
4th Dimension displays the Layout dialog box, the [Employees] file is 
already expanded to show the layouts for that file.

2. Double-click the Employee Input layout.

4th Dimension displays the Employee Input layout. You are going to add 
the Health Plan field to this layout.

3. Select the frame of this layout and make it bigger by dragging the 
lower right corner toward the bottom of the screen.
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4. Click the Add Field icon  on the palette and draw a rectangle in the 
space you have added.

As soon as you finish drawing the field area, 4th Dimension displays the 
Field Definition dialog box. You use this dialog box not only to set the 
field display format (as you have done before), but also to choose the field 
for the field area you have just drawn and to set any data validation 
instructions for that field.

5. Select Health Plan from the list of fields and click OK.

4th Dimension displays the layout with the added field.

6. Select 12-point from the Style menu.

7. Use the Text Area tool  to create a field label, “Health Plan”, and 
make the label 12-point.

Adding a field 
to the layout

Layout frame

List of fields
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8. Align the text to the field with the Align Top tool . 

Remember to select both the new text area and the Health Plan field 
before you click the Align Top tool.

9. Select the Health Plan field and press Ctrl+1 to create a border around 
it.

This tutorial has taken you through adding a field to a layout to 
emphasize this point: new fields are not automatically added to layouts.

You must add a new field not only to the structure of the database, but 
also to any layouts on which you want to use the field.

Of course, any new layouts you create can automatically include the new 
field, along with the other fields in the file.
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SEEING THE CHOICE LIST IN ACTION

As you found in the previous chapters, you can go quickly to the User 
environment to check on work you have done in the Design 
environment.

You want to see how the new choice list affects how you enter 
information into your layout.

1. Choose User from the Use menu.

4th Dimension displays the records in the List layout.

2. Select a record and choose Modify Record from the Enter menu.

4th Dimension displays your modified input layout.

3. Select the Health Plan field.

4th Dimension displays the choice list.

4. Click National.

4th Dimension enters National in the field and removes the choice list. 
The Health Plan field remains selected.

Feel free to experiment with the choice list. You can select a different field 
and then select the Health Plan field to display the choice list again. You 
can select a different entry from the list to replace whatever has been 
previously entered or click the Modify button to return to the List editor 
and add or delete items from the list.

5. When you have finished, click the Enter or Cancel button.

4th Dimension returns to the output layout for this database. 
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THE NEXT STEP

Choice lists provide a convenient and fast way to enter data into a field 
accurately. You create a choice list in the List editor. In this chapter, you 
attached the choice list to a field as a field attribute. In the next chapter, 
you will learn additional ways of using choice lists for data validation.
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Database: People05
Estimated time to complete: 15 minutes

How important is correct information? An incorrect mailing address can 
be either frustrating or disastrous, depending on the information that is 
delayed or not delivered. An incorrect total in your checking account 
statement can be annoying; if it goes unnoticed, it can be ruinous.

There are many ways incorrect information can find its way into a 
database. Information can become outdated, it can be entered incorrectly, 
calculated with an incorrect formula, and so on.

The purpose of data validation is to check the information before the 
record is accepted into the database.

4th Dimension provides many ways to validate data. You can create lists 
of values that are either mandatory or optional. Using field attributes, you 
can ensure that each record contains a unique entry in a field. You can 
establish a range of acceptable numeric values, rejecting any entry that 
does not fall between the upper and lower limits. Or, you can use a script 
to perform almost any type of data validation.

In this chapter you will learn how to:

■ Use field attributes for data validation,

■ Create an entry filter to reduce typing errors in a field,

■ Create upper and lower limits for a numeric field,

■ Use a list to set required entries for a field.
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USING FIELD ATTRIBUTES FOR DATA VALIDATION

Field attributes provide several ways of validating the information that 
you enter into your database. For example, applying the Mandatory 
attribute to any field makes it impossible to enter a record that does not 
have an entry in that field.

The People05 database has a new field for the employee’s social security 
number. You will specify attributes that help to validate the entries in that 
field.

1. If you have not done so already, start 4th Dimension and open the 
People05 database.

People05 opens in the Design environment.

2. Double-click the SS Number field in the [Employees] file.

Double-clicking is a shortcut for choosing Edit Field from the Structure 
menu. 4th Dimension displays the Field Attributes dialog box for the 
SS Number field, ready for you to make any changes to the field’s 
instructions.

If you accidentally click another field in the file, 4th Dimension displays 
the Field Attributes dialog box for that field. If this happens, click Cancel 
and start over.

Notice that the SS Number field is an Alpha 9 field. All social security 
numbers have nine digits. You will use 4th Dimension’s special formatting 
features to allow space for the two hyphens.

3. Select the Mandatory check box.

The Mandatory attribute prevents a record from being accepted without 
a Social Security number.

You will now add other attributes to further protect the integrity of the 



VALIDATING DATA

VALIDATING DATA 5

5-3

Social Security numbers in your records.

4. Select the Indexed check box and then select the Unique check box.

When you select Indexed, the Unique attribute becomes available. 
Unique prevents any duplicate entries from being entered in the 
SS Number field.

5. Click OK.

4th Dimension displays the Structure window. You have successfully 
changed the attributes of a field. The attributes affect the SS Number field 
on every layout on which it appears.

Since the next sections contain additional data validation techniques, 
you may want to wait until the end of this session to see the results of 
these field attributes in the User environment.

USING AN ENTRY FILTER AND A DISPLAY FORMAT

An entry filter checks information entered in a field against a pattern. If it 
matches the pattern, it is accepted; if it does not match the pattern, it is 
rejected. An entry filter can standardize what appears in 
a telephone number field, or, in the case of social security numbers, can 
ensure that the correct number of digits is entered.

An entry filter can be used to set any sort of pattern for entering data. You 
set an entry filter using the Field Definition dialog box, which you can 
display for any field in a layout. 4th Dimension then applies the pattern 
in the entry filter whenever a value is entered into this field on the layout.

The patterns are made up of symbols on your keyboard. The following is 
a short table of the symbols and their meanings:

For more information about creating entry filters, refer to the 
4th Dimension Design Reference.

Symbol Meaning

& Signals that the filter begins

# Placeholder symbol; allows a character

9 Allows any number

a Allows any letter

A Allows any capital letter

~ Forces capital letter

! Signals that a display character follows
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Generally, when you specify an entry filter, you should also specify a 
display format. The entry filter affects data entry only; it has no effect on 
the way a field value is displayed and printed. If you use hyphens in your 
data entry filter, for example, they will be printed only if you also create 
a display format for the field that includes the hyphens.

Entry filters and display formats can be assigned to a field by using either 
drop-down list boxes or by typing. The drop-down list boxes include 
formats and filters for some of the most common types of data that you 
will be using.

1. Double-click the title bar of the [Employees] file.

2. When the Layout dialog box appears, double-click the Validate 
layout.

4th Dimension displays the Validate layout. You are going to use this 
layout for data validation controls.

3. Double-click the SS Number field.

4th Dimension displays the Field Definition dialog box for the SS Number 
field.

4. Choose the filter !0&9###-##-#### from the Entry Filter drop-down list 
box.

This entry filter specifies the entry format for the SS Number field. Each 
entry is forced into this format. Only nine characters can be entered and 
each character must be a number. 

Entry Filter 
drop-down list box
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Note that this entry filter has no effect on the way a value is displayed. In 
order to display the Social Security number with hyphens, you need to 
specify a display format.

5. Choose ###-##-#### from the Format drop-down list box.

The display format appears in the Format Display box.

This display format ensures that the Social Security number will be 
displayed and printed with hyphens. Without the display format, only 
the numbers would be displayed.

6. Click OK.

4th Dimension displays the layout again.

This data validation technique helps prevent data entry errors from 
affecting this field.

Format Display box

Format drop-down 
list box
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ADDING A VALIDATION RANGE

Salaries in your company range from $15,500 to $105,000. These are the 
lower and upper limits of acceptable salary figures. To set these limits to 
validate entries in the Salary field, you enter the Field Definition dialog 
box from the layout again.

1. Double-click the Salary field.

4th Dimension displays the Field Definition dialog box for the Salary field.

You have already used this dialog box to set the display format for this 
field. You will now use it to enter upper and lower limits for an employee’s 
salary.

2. Select the Minimum box and type “15500”.

The lower limit for Salary is set at $15,500.

3. Select the Maximum box and type “105000”.

The upper limit for Salary is set at $105,000.

4. Click OK.

It’s that easy. Whenever a value outside these limits is entered into the 
Salary field, 4th Dimension will refuse the entry and display an alert. You 
will see what the alert looks like on the screen later in this chapter.
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MAKING A LIST REQUIRED

You created a list for the Health Plan field in the previous chapter. The 
People05 database also includes a list for the Title field. You want to 
ensure that only these titles and no others are used in the employee 
records.

A list is commonly used to provide a quick, accurate method for entering 
data. However, unless you make the list itself required, another title can 
be typed in (a feature you would want in many cases). 

Since you want users to enter only valid titles for employees, you are 
going to make the choices on the Titles list required on this layout, which 
means that 4th Dimension will accept only those entries and no others.

1. Double-click the Title field.

4th Dimension displays the Field Definition dialog box for the Title field. 
There are two field attributes you can set on each layout—Enterable and 
Mandatory. These are the same as the Enterable and Mandatory field 
attributes, except that they affect the field only on this layout.

Below the layout field attributes are the lists features. You can attach a list 
to a field for only this layout, make a list required for a field on this layout, 
or exclude a list of values for a field on this layout.

2. Click the Choices check box.

3. Click the List button next to the Choices check box.

4. Select Titles from the list and then click the Select button.

By making Titles a Choice list, the user will be presented with a Choices 
window containing a list of valid employee titles. The Titles list and the 
entries that appear in the list were created for you for this tutorial.
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5. Click the Required check box in the Lists section.

6. Click the List button next to the Required check box.

4th Dimension displays the Lists dialog box.

7. Select Titles from the list and click the Select button.

Now 4th Dimension will accept only entries from the Titles list for this 
field on this layout.

8. Click OK.

Required check box
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VIEWING THE RESULTS

Now that you have added these data validation features to your layout, 
you can see the results in the User environment.

1. Choose User from the Use menu.

4th Dimension displays the output layout. Before using these data 
validation features, you must tell 4th Dimension to use the Validate input 
layout.

2. Press Ctrl+Spacebar to display the List of Files window.

You will use the List of files window to change the input layout for the 
[Employees] file.

3. Click and hold down the mouse button on the Input Layout icon for 
the [Employees] file and choose Validate from the drop-down menu.

4th Dimension changes the current input layout to the Validate layout.

4. Press Ctrl+Spacebar again to bring the output layout to the front. 
OR
Just click on the output layout.

When you press Ctrl+Spacebar again, 4th Dimension hides the List of Files 
window.

5. Choose New Record from the Enter menu.

4th Dimension displays the Validate input layout.
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6. Try entering “106000” into the Salary field.

As soon as you press Tab or Enter, or click on another field, 4th Dimension 
displays an alert box warning that the Salary value is outside the valid 
range of entries for this field.

This is exactly what you want to happen. 

7. Enter a valid salary.

8. Select the Title field, click the Cancel button for the choice list, 
backspace over your entry, and try to type a job title that does not appear 
on the Titles choice list.

4th Dimension refuses the entry. 

9. Click in the Title field again to select one of the valid choices from the 
Choices list.

10. Try entering letters in the SS Number field.

4th Dimension rejects these characters when you type them.

11.  Enter a valid number.

12. Click the Cancel button to cancel the record.
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THE NEXT STEP

The data validation techniques you have used prevent inadvertent errors 
from affecting the information in your database. You may want to try out 
additional techniques. Complete information about using the options in 
the Field Definition dialog box for data validation can be found in the 
4th Dimension Design Reference.

The next chapter gives you an introduction to using scripts and default 
values. A script uses 4th Dimension procedures to perform operations on 
a field or object. A default value is the initial entry which appears in a 
field. Unless it is modified before the user accepts the record, the default 
value is entered into the field.



6-1SCRIPTS AND DEFAULT VALUES

Database: People06
Estimated time to complete: 10 minutes

A script is an instruction or series of instructions for 4th Dimension to 
execute. You can use a script to calculate a value for a field, ensure that 
text entries are capitalized, validate an entry, display a timely warning to 
the user, and so on.

A default value is an entry that automatically appears in a field when a 
record is first opened. It remains that field’s value until you change it by 
entering a different value. You can set a static value for a field’s default 
value, or you can use a dynamic default value calculated by 
4th Dimension. 4th Dimension provides a calculated default value for 
current date, current time, and current sequence number.

In this chapter you will learn how to:

■ Create scripts to calculate values,

■ Enter and use default values.

SCRIPTS AND DEFAULT VALUES 6
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ABOUT SCRIPTS

A script is one type of 4th Dimension procedure. A script is usually short, 
from one line to only a few lines long and is always associated with an 
object on a layout (a field, a button, or some other active object). When 
4th Dimension executes a script, it carries out the instructions provided by 
the script.

The Procedure Editor
When you write a script, you do so using one of 4th Dimension’s two 
Procedure editors. You have the choice of using the Flowchart editor or 
the Listing editor. 

The Flowchart editor is a graphically oriented procedure editor in which 
the instructions are presented as a series of steps and tests that are 
connected with flowlines. The Listing editor is a line editor in which the 
steps and tests are written as text.

If you have used flowcharts to diagram procedures, you may find the 
Flowchart editor more useful to you. However, most people are familiar 
with procedures written as a listing. You should also keep in mind that 
only those procedures written using the Listing editor can be compiled. 
The tutorials in this book use the Listing editor.

The upper portion of the Procedure editor is where you enter and edit the 
commands, functions, and other elements that make up the script. You 
type the script into the text area. You can select many of the script’s 
elements from the selection panels in the lower portion of the window. 

Keywords area

Files area

Routines area
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The lower portion of the Procedure editor contains the following 
selection panels:

Keywords: The Keywords list contains symbols and phrases you use to 
build your procedure. The most commonly used symbol is “:=”. It is called 
the assignment operator. Use it to instruct 4th Dimension to place a value in 
a field (or in a variable). For example, the statement:

[Employees] Monthly Salary := [Employees] Salary/12

reads “Monthly Salary gets Salary divided by 12.” This statement instructs 
4th Dimension to take the value in the Salary field, divide it by 12, and 
place it in the Monthly Salary field.

Files: You can select fields or layouts from the current file by clicking 
them in the Files list. You can display fields and layouts from other files 
in the database by clicking on the cycle arrows on either side of the file 
name.

Routines: The Routines list contains commands and functions provided 
by 4th Dimension. By default, these commands and functions are grouped 
into subjects, or themes, which are listed in alphabetical order. You choose 
commands and functions from these themes as you do from a drop-down 
list box. 

Commands for any 4th Dimension modules you have installed appear at 
the end of the Routines list, in their own themes.

A command carries out a task. For example, the ALERT command displays 
text in an alert window. A function returns a value. For example, the Round 
function rounds off a number and returns the new value.

Cycle arrows
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Writing a Script
You have decided to add the monthly salary of each employee to the 
database. You are going to use a script to calculate the value by dividing 
each employee’s yearly salary by 12. 

You are first going to create a new Monthly Salary field.

1. If you have not done so already, start 4th Dimension and open the 
People06 database. 

The People06 database opens in the Design environment.

2. Create a new field called Monthly Salary. Make it a Real field and 
select the Display Only attribute.

The Monthly Salary field will contain a calculated value. You make this 
field Display Only to prevent a different value from being accidentally 
entered into it. Creating a field is described in Chapter 4 of this manual.

The new field does not yet appear on any layouts. You need to add it to 
an existing layout in order to display the monthly salary for each 
employee.

3. Open the Scripts layout.

You are going to add the new field to this layout.

4. Use the Add Field tool  to place the Monthly Salary field on the 
layout below the SS Number field. 

Placing a field on a layout is described in Chapter 4 of this manual. 
4th Dimension displays the Field Definition dialog box.

5. Select Monthly Salary from the list of fields.

6. Set the numeric display format by typing “$###,###.00” into the 
Format Display box.
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Typing this set of symbols is another method of setting the numeric 
display format instead of choosing it from the drop-down list box.

Although you could choose this format from the Format drop-down list 
box, you normally use the Format Display area to enter formats not in the 
drop-down list box. You can also use the Format Display area to modify 
entries that you choose from the drop-down list box.

7. Click OK.

8. Make the field 12-point.

9. Create a text area next to your new field and type “Monthly Salary”.

You are now going to add a script to the Salary field that computes a value 
for Monthly Salary.

1. Double-click the Salary field.

4th Dimension displays the Field Definition dialog box for Salary.

2. Set the numeric display format by typing “$###,###.00” into the 
Format Display box.

3. Click the Script button.

4th Dimension displays the Procedure Type dialog box, which offers you a 
choice of using the Flowchart or Listing method for writing the script.

Format Display box
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4. Leave the Listing radio button selected and click OK.

4th Dimension displays the Procedure editor in a window entitled 
“Script: Salary.”

The script you will enter is as follows:

[Employees]Monthly Salary := [Employees]Salary/12

This script reads “Monthly Salary gets Salary divided by 12.” You can 
often write a script simply by clicking items in the three panels at the 
bottom of the window. In the next steps you will select the field names 
from the middle panel and the assignment operator (:=) from the left 
panel. You will type the division symbol and the number.

5. Click and hold down the mouse button on the filename area. 

The File drop-down menu appears.

6. Select the [Employees] file.

7. Click Monthly Salary.

4th Dimension enters the file and field name in the top part of the 
window.

8. Click the := symbol at the top of the Keywords list in the left panel.

4th Dimension enters the symbol next to the Monthly Salary field name.
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9. Click Salary in the middle panel.

10. Type: “/12” and press the Enter key on the keyboard (not on the 
numeric keypad).

The script is now complete.

11. Double-click the Control-menu box to close the Procedure editor 
window.

4th Dimension displays the Scripts layout in its window. A triangle in the 
Salary field indicates that a script is attached to it.

In a later section you will view the results of this script in the User 
environment.
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USING A DEFAULT VALUE

You normally enter an employee’s record on the first day that the 
employee starts work. The Start Day field, therefore, almost always 
contains the current date on the day the record is first created. You have 
decided to enter a default value to make data entry for this field faster.

1. Double-click the Start Day field.

4th Dimension displays the Field Definition dialog box for the Start Day 
field.

2. Click in the Default box and type “#D”.

This is a code for setting the current date as the default value for a field. If 
the record for a new employee is entered on April 23, 1995, the Start Day 
field will contain the date Apr 23, 1995 (the date in Abbreviated format) 
as a default value.

3. Click OK.

4th Dimension displays the layout again. Subsequently, when you create a 
new record, the current date will already be entered in the Start Day field. 
You can type over the default value if necessary.

4th Dimension also lets you use default values for the current time (#H) 
and for a sequence number (#N). For more information about default 
values, refer to the 4th Dimension Design Reference.



SCRIPTS AND DEFAULT VALUES

SCRIPTS AND DEFAULT VALUES 6

6-9

SEEING THE RESULTS IN THE USER ENVIRONMENT

Now that you have added a field, script, and default value to the layout, 
you can see the results in the User environment.

1. Choose User from the Use menu.

You modified the Scripts input layout. Before you can see the results of 
your work, you need to switch input layouts.

2. Change the input layout by choosing Scripts from the List of Files 
window.

You display the List of Files window by pressing Ctrl+Space bar. Choosing 
the input layout from the List of Files window is described in Chapter 2 
of this manual.

3. Choose New Record from the Enter menu.

4th Dimension displays the Scripts input layout. The current date is 
displayed in the Start Day field.

4. Enter “74000” in the Salary field.

4th Dimension calculates the new monthly salary figure and displays it in 
the Monthly Salary field.

The Monthly Salary field now contains information that can be used in 
another place. If your payroll were set up to obtain the monthly salary 
figure from this field, any changes to an employee’s salary would be 
immediately reflected on the payroll.

5. Click the Cancel button to cancel the record.
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THE NEXT STEP

Scripts and default values can reduce the amount of time spent during 
data entry and increase the accuracy of the information in your database.

In Chapters 7 and 13 of this manual, you will see more examples of using 
scripts. You will use the scripts to capitalize the entries in a field and to 
calculate totals and subtotals for a report.

In the next chapter you will use the Procedure editor to create a global 
procedure which you can then use in scripts for several fields.
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Estimated time to complete: 20 minutes

Now that you have created a script in Chapter 6, you may begin to see 
how useful 4th Dimension procedures can be. A script is a procedure that 
is associated with a field or other object in a layout. In addition to using 
commands and functions in a script, 4th Dimension allows you to write 
procedures that can be used within a script to perform a specific function. 
A global procedure can be written once and used in many scripts and 
procedures.

In this chapter you will write a procedure that capitalizes the first letter of 
a field entry. You will then use this procedure in scripts that you attach to 
two different fields.

You will learn how to:

■ Open the Procedure editor,

■ Write a global procedure,

■ Use the global procedure in scripts.
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4TH DIMENSION PROCEDURES

4th Dimension uses several kinds of procedures:

■ Global procedures: A global procedure can be used in other procedures 
or be activated by a menu command. Use a global procedure when you 
need to perform the same task more than once. 

■ Layout procedures: A layout procedure is associated with a particular 
layout. It is executed before the layout is displayed, whenever a field or 
other object is selected or modified, and again after the record is accepted.

■ Scripts: A script is a procedure that is associated with an object on a 
layout. It can be executed as often as a layout procedure, or only when the 
object is used.

■ File procedures: A file procedure is associated with a file. A file 
procedure is executed before any input layout for that file is used.

In this chapter you will create a global procedure. You have already 
created and used scripts in Chapter 6, “Using Scripts and Default Values.” 
File and layout procedures are not covered in this book. For complete 
information about these types of 4th Dimension procedures, refer to the 
4th Dimension Design Reference.



CREATING PROCEDURES

CREATING PROCEDURES 7

7-3

OPENING THE PROCEDURE EDITOR

Whenever you write a procedure, you use 4th Dimension’s Procedure 
editor. For a script, you open the Procedure editor from within the Layout 
editor. For the other types of procedures, however, you use the Procedure 
menu command in the Design menu.

1. If you have not done so already, start 4th Dimension and open the 
People07 database.

People07 opens in the Design environment.

2. Choose Procedure... from the Design menu.

4th Dimension displays the Procedures dialog box.

The Procedures dialog box shows all the global, file, and layout 
procedures associated with this database. At this point, there are no 
procedures to list. Later you will be able to expand and collapse the lists 
to see the procedures that you have created. You use the 
Expand/Collapse button as in the Layout dialog box to expand and 
collapse layout names. When you highlight a layout procedure, 
4th Dimension displays the layout it is associated with in the Layout 
Display area.

You must choose in this dialog box whether your procedure is to be a 
global, file, or layout procedure. Because you are writing a procedure that 
will be called by other procedures, you make it a global procedure.

The Global Procedures choice is already selected, so you do not need to 
change it. If you have deselected the Global Procedures choice, be sure to 
select it before continuing.

Procedure list

Layout Display area
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3. Click the New button.

4th Dimension displays the Procedure Type dialog box.

Here you name your global procedure and choose whether to use the 
Listing or the Flowchart method for writing your procedure.

If you are accustomed to using flowcharts to map out or diagram 
procedures, you may find the Flowchart method appropriate. However, 
most people are familiar with a listing format in which the procedures are 
written out line by line.

The choice between the two methods is available only for a new 
procedure (such as this one). Subsequently, you can edit the procedure 
only in the form in which you first write it. 

Since most people prefer the Listing method, it is preselected. For the 
purposes of this tutorial, do not change the selection.

4. Type “Uplow” in the Procedure Name box.

Uplow is a descriptive name for the procedure you will write. It makes the 
first letter uppercase and the remainder of the letters lowercase.

5. Click OK.

4th Dimension displays the Procedure editor in a window entitled 
Procedure: Uplow. You use the Procedure editor to write and edit 
procedures.

Procedure 
text area

Keywords area

Files area

Routines area
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The upper portion of the Procedure editor is where you enter and edit the 
commands, functions, and other elements that make up the procedure. 
You can select most procedure elements from the selection panels in the 
lower portion of the window. 

■ Keywords: The Keywords list consists of symbols and phrases you use 
to construct your procedure.

■ Files: You can select fields and layouts from the current file by clicking 
them in the Files list. You can display fields and layouts from other files 
in the database by clicking on the cycle arrows on either side of the file 
name to change files.

■ Routines: Commands and functions provided by 4th Dimension are 
listed in the Routines list. Commands and functions can be listed in 
alphabetical order or by groups (the default), also called themes. You click 
the word Routines at the top of the panel to select either an alphabetic or 
a grouped listing of the routines.

CREATING A CAPITALIZATION FUNCTION

You are now going to write a function to capitalize field entries. This 
function is useful for preventing typing errors from being stored in your 
database. When you use this function in scripts, you can be sure that the 
names are capitalized properly.

The procedure you will enter is as follows:

If ($1 # "")
$0 := Lowercase ($1)
$0_<1>_ := Uppercase ($0_<1>_)

End if

The second line in the procedure changes all characters in the field to 
lowercase and the third line converts the first character in the field to 
uppercase. These actions are performed by two built-in 4th Dimension 
functions, Lowercase and Uppercase.

The names $0 and $1 are the names of variables that you create 
automatically by using them. By convention, $1 is reserved for the value 
that is passed to a function, while $0 is reserved for the value that is 
returned by a function. 

In other words, the input to the function is contained in $1 and the 
output from the function is contained in $0. 

A version of Uplow can be written simply by using the field names that you 
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want to use. For example, you could write the procedure as follows:

If (LastName # "")
Last Name := Lowercase (Last Name)
Last Name_<1>_ := Uppercase (Last Name_<1>_)

End if

This function would work fine, but only for the Last Name field. It would 
not work for any other fields. You would have to rewrite the function for 
each field you wanted to capitalize. Using the names $1 and $0 allows you 
to reuse the Uplow procedure for any alphanumeric field or variable.

In this tutorial, you will write the Uplow procedure and then use it in 
scripts for both the First Name and Last Name fields. 

The following steps do not specify whether to select or type the elements 
of the procedure. Try both ways. You will soon be able to decide which 
method works best for you.

1. Click the maximize button to expand the Procedure editor window.

2. Type the following comment to identify the purpose of the procedure: 
“`Uplow capitalizes the first letter of the field entry”.

The leading accent mark indicates that this is a comment and not part of 
the instructions. The accent mark appears in different places on different 
keyboards. Do not confuse this accent mark with the apostrophe or 
backslash.

3. Press the Enter key on the keyboard.

When you press Enter, the comment is entered and automatically 
indented. The insertion point moves to the next line.

4. Type “If ($1 # "")”.

This line guarantees that $0_<1>_ is a valid character reference.

You begin on the third line with the first local variable and the 
assignment operator (:=).

5. Type “$0:=”.

This can be read as the “value returned gets.” The value returned will be 
the lowercase version of the contents of the field. The remainder of the 
first line will create the lowercase version.

6. Type “Lowercase ($1)” and press the Enter key.

This part of the function tells 4th Dimension to make the first value passed 
to the procedure ($1) lowercase. You begin by making all the characters 
lowercase so that when you make the first character uppercase, the entry 
is correct.
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7. Type “$0_<1>_:=”.

This portion of the line can be read as “the character in the first position 
of the value returned gets.”

8. Type “Uppercase ($0_<1>_)”.

This part of the procedure tells 4th Dimension to make the letter in the 
first position (and only the first position) uppercase. The entries in the 
parentheses instruct 4th Dimension to change the first character of the 
value returned by the first line of the procedure.

9. Type “End if”.

10. Press Enter to end the line.

The completed procedure looks like this:

11. Close the procedure by double-clicking the Control-menu box.

The Uplow procedure is now finished. In the next section, you will use this 
procedure within scripts to capitalize field entries.
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USING THE GLOBAL PROCEDURE IN SCRIPTS

Now that you have a procedure that capitalizes the first letter of a word, 
you can use it in scripts to see how it works.

1. Choose Layout from the Design menu and open the Scripts layout.

2. Hold down the Alt key and click the Last Name field.

4th Dimension displays the Procedure Type dialog box. 

3. Select Listing and click OK.

Holding down the Alt key while you click a field or object is a shortcut 
used to open the Script editor. It is equivalent to double-clicking a field or 
object and then clicking the Script button in the Field or Object 
Definition dialog box.

4. Create the following script for this field: 

“Last Name := Uplow (Last Name)”

Placing the field name in parentheses after the name of the procedure 
instructs 4th Dimension to pass the contents of the field to the function. 
In this case, the $1 variable in the Uplow procedure is a placeholder for the 
Last Name field. The final $0 value returned by the function is placed in 
the Last Name field. 

5. Press the Enter key on the keyboard.

After you press Enter, Uplow is displayed in italics. The names of 
procedures are always italicized in the Procedure editor.

In addition, the name of each global procedure you create is 
automatically added to the end of the Routines list in the Procedure 
editor. Scroll through the Routines list to see Uplow listed.

6. Close the script by double-clicking its Control-menu box.

7. Create a similar script for the First Name field by holding down the Alt 
key, clicking on the First Name field, and typing: 

“First Name:=Uplow (First Name)”

In this case, $1 in Uplow is a placeholder for the First Name field. Using the 
local variables $0 and $1, you can write a global procedure without 
naming the specific fields that will be used with it.

You can now test your scripts.

8. Go to the User environment and enter a new record.

Be sure to use random uppercase and lowercase letters for the field entries 
for Last Name and First Name. You will see how the script corrects the 
entries as soon as you select another field.
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THE NEXT STEP

The global procedure you have written will capitalize any field entry 
consisting of a single word. Global procedures such as this one can be 
used in any other procedure or script. You can use it in any script on any 
layout to ensure uniform capitalization. 

In Chapter 15 of this manual you will write a global procedure that you 
attach to a menu command for a runtime 4th Dimension application.
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In this chapter you will create a second file to store information about the 
departments in your company. On each employee’s record, you want to 
include the name of the department for which the employee works and 
the name of the department manager. 

However, you do not want to duplicate the information in each employee 
record. Duplicating information is inefficient, creates extra work in the 
long-run, and takes up more memory. For instance, if a department hires 
a new manager, you would have to change the manager’s name on every 
employee record for that department.

To avoid this, you can combine information from the two files, relating 
them so that you can display information from the [Departments] file in 
a layout for the [Employees] file. Relating the files allows you do things 
such as print a list of employees and their managers or sort the employee 
records by department.

If you keep the department name in a related file, you need to enter it and 
store it on disk only once. You can then display the department name on 
each employee record. If you need to change the information, you need 
change it in only one place, in the [Departments] file. The change is then 
automatically reflected in the other files that use it.

In this chapter you will learn how to:

■ Create a second file,

■ Relate one file to another,

■ Create a layout that displays information from a related file.

This is how relating works: You use fields and layouts to store information 
about each department in the [Departments] file. After you enter the data, 
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the information looks like this:

Each department has one record. Each record contains the department 
name, the department code, the manager’s name, the department budget, 
and the total department salaries.

You use the Department Code field to relate the [Employees] file to the 
[Departments] file. Because the department code identifies a unique 
record in the [Departments] file, 4th Dimension can locate and use the 
information in that one record automatically.

Whenever a record in the [Employees] file is displayed (or otherwise made 
the current record), 4th Dimension uses the department code in the 
employee record to locate the corresponding record in the [Departments] 
file and then loads the record. The information in the department record 
can be used in many ways. For example, it can be displayed on the layout 
for each employee’s record or printed together with other employee 
information.

In this relation, the department code identifies one record in the 
[Departments] file and many records in the [Employees] file. This is called 
a Many-to-One relation. Many employee records have the same 
department code, but that code is entered in only one department record. 
You may be familiar with calling these files the One file and the Many file.
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CREATING A NEW FILE

In this section you will create a second file to store information about 
departments.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE08 database.

4th Dimension displays the Structure window with the [Employees] file in 
it. A new Department Code field has been added to the [Employees] file. 
This is the field you will use to relate the [Employees] file to the 
[Departments] file.

2. Choose New File... from the Structure menu.

The pointer changes to a square file icon  (the same shape that 
4th Dimension uses to display a file). It remains file-shaped until the next 
step.

3. Position the pointer to the right of the [Employees] file and click the 
mouse button.

[File2] is created at that location. You can move a file to any location by 
dragging its filename.

NOTE: If you change your mind about creating a file after you have chosen New File from 
the Structure menu, you can cancel the menu command by moving the file-shaped 
pointer into the menu bar and clicking. The pointer returns to an arrow.

4. Name the file “Departments” by choosing Edit File from the Structure 
menu, typing the filename in the dialog box, and then clicking OK.

You now have two files. You can create up to 255 files in a single database.
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5. Create the following fields for the [Departments] file:

6. Create an input layout in the Departments file named “Dept Input” 
that includes all the fields in the file.

Use layout template #5 (the one in the middle) to see what it looks like 
and to differentiate the [Departments] layout from the [Employees] 
layout.

7. Create an output layout in the Departments file named “Dept Display” 
that includes all the fields in the file. Use layout template #1 (the one in 
the upper-left corner).

You are now ready to relate the two files.

Field name Type Attribute
Code Alpha 5 Indexed

Name Alpha 15

Manager Alpha 15

Budget Real

Total Salaries Real Display Only
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RELATING TWO FILES

First you will relate the [Employees] file to the [Departments] file. Then 
you will create a new layout for the [Employees] file that includes 
information from the [Departments] file.

You establish a relation between two files by drawing a line that connects 
the related fields, that is, the fields that have information in common. In 
this case, the related fields are the Department Code field in the 
[Employees] file and the Code field in the [Departments] file. The two 
fields that you relate do not have to have the same name, but they must 
have the same field type. In addition, both fields must be indexed. If you 
do not index them, 4th Dimension will index them the first time you 
switch to the User environment.

1. Position the pointer on the Department Code field name in the 
[Employees] file.

Because the [Employees] file is the Many file, you start with it. 

Whenever you draw a line to relate two files in 4th Dimension, you 
always start with the Many file.

The Many file contains many instances of the common information, in 
this case, many instances of the department code. The Code field in the 
One file contains only a single instance of each code.

The Department Code field will be related to the Code field in the 
[Departments] file. These fields will contain the information that allows 
4th Dimension to find corresponding records.

2. Press and hold down the mouse button on the Department Code field 
in the [Employees] file and drag the pointer to the Code field in the 
[Departments] file.

A line follows the pointer.
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3. With the pointer positioned on the Code field in the [Departments] 
file, release the mouse button.

4th Dimension displays the Relations dialog box.

The line you have just drawn establishes the relation between the two 
files. 4th Dimension can locate the record in the One file that corresponds 
to a record in the Many file (the relation is many records related to one 
record). 4th Dimension can also locate the records in the Many file that 
correspond to a record in the One file (the relation is one record related 
to many records).

The Deletion Control options tell 4th Dimension how to treat related 
records in the Many file when their related record in the One file is 
deleted. For more information about these options, refer to the 
4th Dimension Design Reference and the 4th Dimension User Reference. For 
now, leave the default Deletion Control option selected.

4. Click Name in the Wildcard Choice list.

For complete information about the Wildcard Choice list, refer to the 
4th Dimension Design Reference.

5. Click OK.

4th Dimension displays the Structure window again with an arrow 
pointing from the [Employees] file to the [Departments] file. The arrow 
shows that the two files are related. The arrow points from the 
Department Code field in the [Employees] file (where you started) to the 
Code field in the [Departments] file (where you ended).

If you made an error in drawing the line, you can correct it by simply 
removing the relation and then redrawing it. To remove a relation, click 
on the field at which you started the relation and drag the pointer to any 
blank area on the Structure window. When you release the mouse button 
over the blank area, the relation disappears. 
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LAYOUTS WITH FIELDS FROM THE RELATED FILE

You have related the [Employees] file to the [Departments] file. Whenever 
you enter a department code on a layout for the [Employees] file (or 
otherwise make that record current), 4th Dimension loads the 
corresponding record from the [Departments] file. You can then use 
information from that [Departments] record.

Your next step is to create a layout to display information from both files. 
This will be a new input layout for the [Employees] file.

1. To open the Layout dialog box, double-click the title of the 
[Employees] file.

4th Dimension displays the Layout dialog box, showing the layouts for the 
[Employees] file already expanded. Because you double-clicked the 
[Employees] file, only the layouts for that file are shown.

2. Click the New button to display the New Layout dialog box.

Notice that the field that you used to relate the two files (Department 
Code) is now in bold type and the file it is related to ([Departments]) is 
shown in brackets next to it. The [Departments] file is also shown at the 
end of the list of fields. This second listing allows you to create an 
included layout. You will work with the second listing of a file in the next 
chapter.

3. Double-click the Department Code field name.

4th Dimension expands the list to show the fields from the [Departments] 
file. You can include any of these fields in the layout you are now creating.

When you are creating a layout that includes fields from a related file, you 
must select all the fields you want to display. The fields will appear in your 
layout in the order you select them.

Field used to 
relate the files

Fields from 
[Departments] file
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To select a field for your layout, you can either click the field name and 
then click the Select button or you can simply double-click the field.

4. Select these fields from the [Employees] file in the following order:

Last Name
First Name
Start Day
Salary
Title

5. Select the Department Code field in the [Employees] file by clicking 
the Select button.

6. Select the following fields from the [Departments] file:

Name
Manager

4th Dimension displays numbers beside the selected fields. These numbers 
show the order in which the fields will appear on the layout.

7. Type “Related” as the layout name and choose the 9-point font size.

8. Click OK.

4th Dimension displays the new layout you have created. The two field 
labels for the fields you selected from the [Departments] file are displayed 

Layout font size
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on this layout in bold type and the field labels from the [Employees] file 
are shown in plain type.

You can now enter records in the User environment.

IMPORTING DEPARTMENT RECORDS

Now that you have related the two files and have created a layout that 
includes fields from both files, you can see the result as you enter 
additional records.

You must first add records for the [Departments] file. A text file of 
department records is included in the PEOPLE08 directory.

1. Choose User from the Use menu.

4th Dimension displays the list of employee records you have been using.

2. Make [Departments] the current file.

Before you can import data, you must make the file that will contain the 
data the current file.

To change the current file, press Ctrl+Space bar and select the file you 
want to make current from the List of Files window. Then press Ctrl+Space 
bar again to hide the List of Files window.

3. Choose Import Data... from the File menu.

An Open File dialog box appears.

4. Open the PEOPLE08 directory, and then select the DEPTMENT.TXT 
file in the file list.

5. Click OK.
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4th Dimension displays the Data Import dialog box. You are going to use 
this dialog box to import data into the [Departments] file from a text file. 

Columns in the upper portion of the dialog box preview the data in the 
text file by showing the first four lines of text. If the text file contained 
more than five columns of data, you would use the scroll bar at the 
bottom of the columns to see additional columns.

In this dialog box, you need to specify into which fields you want to 
import data. All of the fields in the [Departments] file are contained in the 
drop-down list boxes that appear at the top of each column. To select a 
field for each column of data, you choose a field name from the drop-
down list boxes. 

For this exercise, you want to import data into all fields in the 
[Departments] file in the order that they appear in the file.

1. Choose the Code field name from the drop-down list box in the first 
column.

4th Dimension places “Code” at the top of the column.
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2. Choose Name from the drop-down list box in the second column, 
Manager from the third, and so on.

3. Click OK. 

A progress indicator appears and counts the records as they are being 
imported into the [Departments] file.

Once all the records are imported into the [Departments] file, 
4th Dimension displays the records in the output layout.

For further information about importing records, refer to the 
4th Dimension Quick Start.
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SEEING THE RELATION IN ACTION

In this section you will see that when you enter the department code on 
an employee record, 4th Dimension immediately displays the information 
from the [Departments] file.

To see how the automatic relation works, you will need to use the Related 
layout you just created.

1. Press Ctrl+Space bar to display the List of Files window.

2. Click the Input Layout icon for the [Employees] file and choose 
Related from the drop-down menu.

4th Dimension changes the current input layout to the Related layout you 
just created.

3. Press Ctrl+Space bar again to bring the Records window to the front.

4th Dimension hides the List of Files window.

4. Choose New Record from the Enter menu.

5. Enter some practice information:

Last Name:“Ormolu”
First Name:“Fritz”
Start Day:“4/1/89”
Salary:“38050”
Title:“Fabricator”

6. Select the Department Code field.

7. Enter “DES” and press the Tab key.

4th Dimension enters the department name (Design) and the manager’s 
name (Mr. Wanamaker) in their fields. This information came from the 
[Departments] file. You can now see the first benefit of the relation you 
have established: automatic, instantaneous, and accurate data retrieval.

8. Click the Enter button.

4th Dimension accepts the record and displays a blank record for further 
data entry.
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ACCESS TO THE RELATED FILE

You will occasionally need to access a related file. You may need to create 
a record for a new department, for example. 4th Dimension makes this 
easy to do. When you enter a new department code, 4th Dimension gives 
you access to the input layout of the related file so that you can create the 
new record.

Suppose your company hires an engineer as the first employee of a new 
engineering department. You enter this record before the department 
record is created.

In this section, you will enter a new department code and then create the 
corresponding department record.

1. Enter some practice information:

Last Name:“Conqueror”
First Name:“Bill”
Start Day:“10/1/88”
Salary:“45000”
Title:“Engineer”

2. Enter “ENG” in the Department Code field.

When you tab out of the field, select another field, or click the Enter 
button, 4th Dimension looks for this code in the [Departments] file. When 
it does not find the record, it decides that you have either made a mistake 
or you want to create a new record. 

A confirmation dialog box appears asking if you want to create a new 
department record or try to enter an existing department code in the 
employee record.
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3. Click the Create It button.

4th Dimension displays the input layout for the [Departments] file, ready 
for you to enter information about the Engineering department. 

The new department code is already entered in the correct field. To create 
a new record in the [Departments] file, you need only fill out the rest of 
the form.

4. Enter the Engineering department information:

Name:“Engineering”
Manager:“Mr. Sturges”
Budget:“175000”

You can ignore the Total Salaries field for the moment. This field has a 
Display Only attribute that prevents any value from being entered. Later 
you will instruct 4th Dimension to calculate a value for this field.

5. Click the Enter button to accept the record.

4th Dimension accepts the record, returns to the input layout for the 
[Employees] file, and displays the department and manager information 
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in the related fields. This information has been drawn from the record you 
created in the [Departments] file.

6. Click the Enter button.

The employee records are listed in the output layout for the [Employees} 
file.

THE NEXT STEP

You have seen how related files allow you to share information between 
files. Your employee records now include the appropriate department and 
manager names. You will see in the next chapter that the department 
layouts can include information about the employees in each 
department.

Since the files can share this information, data that might have been 
repeated many times is stored only once. The advantages of this structure 
are reduced data entry time, less chance of error, ease of updating, and 
usage of less disk space.

You can create reports that use information from the related file. You can 
also search and sort records based on information in the related file. For 
example, you can sort the records in the [Employees] file by department 
or by manager even though the department name and manager’s name 
are in the [Departments] file. You will see these operations in later 
tutorials. 
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In this chapter you will use the relation you established in Chapter 8 to 
display records from the [Employees] file in a layout for the [Departments] 
file. This is called a One to Many relation.

Relating One to Many means that whenever a record in the [Departments] 
file is made current, 4th Dimension loads all the [Employees] file records 
that have the same department code. This capability allows you to use 
information from many employee records from within each of the records 
in the [Departments] file. Many records contribute information to one 
record

In this chapter you will learn how to:

■ Create a layout that includes records from the Many file,

■ Modify an employee record from within the [Departments] file.
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CREATING AN INCLUDED LAYOUT

You want to create a layout that displays all employees belonging to a 
department on that department’s record. To do this, you need to create a 
layout for the [Departments] file that includes space for [Employees] 
records. 4th Dimension provides an automatic method for including 
records from another file which is similar to the way you created the 
Related layout to display information from the [Departments] file.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE09 database.

PEOPLE09 opens in the Design environment.

2. Double-click the title of the [Departments] file to open the Layout 
dialog box and click the New button.

4th Dimension displays the New Layout dialog box for the [Departments] 
file. 

This dialog box shows the field names from the [Departments] file. The 
[Employees] filename is shown in bold and in brackets at the bottom of 
the list of fields. You will select two [Departments] fields and several 
[Employees] fields to display on the same layout.

3. Select Name and Manager from the [Departments] file.

4. Click the [Employees] filename and click the Select button.

5. Double-click the [Employees] filename.

4th Dimension lists the fields in the [Employees] file.

6. Select Last Name, First Name, Start Day, and Salary in that order from 
the [Employees] file.

Be sure to select them in that order so that they appear in that order on 
the layout. If you make a mistake, you can deselect any field name by 
reselecting it.

The numbers for the fields from the [Employees] file start over again from 
number 1. This is because the fields are numbered within the included 
layout area.
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7. Select the fifth layout pattern (the one in the middle), make the font 
size 9-point, and type “Included” as the layout name.

8. Click OK.

4th Dimension displays the new layout.

9. Drag the window to display the included layout area.

4th Dimension has automatically placed an included layout area on the 
new layout. An included layout area displays records from another file. 
On this layout, the included layout area will show the employee records 
in a multi-line scrollable list format. At present, no fields are visible in the 
included layout. You will see them in the User environment.

Included layout 
area
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VIEWING AND ENTERING RECORDS

You can now go to the User environment to view department records that 
contain employee information. Each time a particular record is made 
current, 4th Dimension searches for all the employee records that match 
the department code and selects them. 4th Dimension then displays the 
information in the fields that you have selected.

1. Choose User from the Use menu.

4th Dimension displays the employee records. You need to change the file 
and layout.

2. Press Ctrl+Space bar to display the List of Files window.

3. Click the Input Layout icon for the [Departments] file and choose 
Included from the drop-down menu.

4th Dimension changes the current file to [Departments] and the input 
layout to the Included layout.

4. Press Ctrl+Space bar again to send the List of Files window to the 
back.

4th Dimension displays the department records in the [Departments] file 
output layout.

5. Select the Administration Department record and choose Modify 
Record from the Enter menu.

4th Dimension displays the new input layout, including a scrollable list of 
Administration Department employees.

You can modify the employee records from this layout. Suppose one 
employee, Mary Smith, has received a raise of $3,000 per year. You can 
change the salary figure here.

Records from the 
[Employees] file
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Database: PEOPLE10
Estimated time to complete: 25 minutes

In this chapter you will use 4th Dimension to store information about 
each employee’s performance reviews. You have no way of knowing in 
advance how many reviews a particular employee has had. New 
employees have had no reviews; others who have been with the company 
a long time have had many reviews. You need to keep track of varying 
amounts of information for each record.

A 4th Dimension subfile handles this problem. A subfile is a subordinate 
file that can contain any number of records associated with a single record 
in the parent file. It lets you keep track of a variable amount of 
information for each record, from no entries to as many as necessary. In 
effect, each employee record will have an entire data file in which to store 
that person’s performance review information.

The file to which a subfile is attached is called the parent file. The records 
in the parent file are called parent records. The fields in a subfile are called 
subfields and the records in a subfile are called subrecords.

Each parent record has its own subfile and the subrecords in each subfile 
are automatically linked to the parent record. 

A parent file can have many subfiles.

In this chapter you will learn how to:

■ Create a subfile,

■ Create a layout that displays information from the subfile,

■ Enter information into the subfile.
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WHY USE A SUBFILE?

You use a subfile when you need to keep track of a varying number of 
additional entries for each record. A subfile is an excellent place to store 
information limited to one record. You might use a subfile to keep track 
of your employee’s children, articles published, or social service awards.

The subrecords (the records in the subfile) are stored with the parent 
record. When the parent record is made the current record, the subrecords 
are placed in memory. The number of subrecords a subfile can contain is 
limited only to the number that will fit in memory.

Note that the information in a subfile is available only when its parent 
record is current. Therefore, it is difficult to summarize information from 
subrecords belonging to different parent records. (Do not use a subfile 
when you need to collect information from all the subrecords.) 

For example, an invoice file might seem to be a good candidate for using 
a subfile because each set of purchased items could be associated with a 
specific customer record. However, since you usually need direct access to 
such purchase records, you would need to use a normal file and an 
automatic relation to store the sales information. You would then relate 
the sales file to the customer file to prepare invoices.
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CREATING A SUBFILE

You create a subfile in two steps: first, you add a field with a subfile field 
type to the parent file ([Employees]). Second, you add fields to the subfile 
in the normal way. Once the subfile exists, you can create a new layout 
for the [Employees] file that includes the subfile.

Notice that creating a subfile is quite different from creating a relation 
between two files that already exist. You cannot convert a file that already 
exists into a subfile.

In the following steps you will create the subfile.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE10 database.

PEOPLE10 opens in the Design environment.

2. Double-click in the space below the field names in the [Employees] 
file.

4th Dimension displays the Field Attributes dialog box.

3. Type “Review Info” for the field name.

This is the name 4th Dimension will use for the subfile as well as the field.

4. Select the Subfile field type.

5. Click OK.

4th Dimension creates the subfile below the [Employees] file and connects 
it to the Review Info field with a gray line.

The gray line connects the top of the subfile to the parent file. Notice that 
this is different from the arrow that connects two related fields.
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Next, you create fields in the subfile (subfields) to contain the 
information. These steps are the same as those for a regular file.

1. Double-click within the subfile.

4th Dimension displays the Field Attributes dialog box.

2. Create the following subfields:

Subfield Type
Review Date Date
Rating Real
Comments Text

The Review Date subfield will contain the date the performance review is 
approved. 

The Rating subfield is for the numerical rating your company uses for 
performance reviews. 

The Comments subfield will contain the text of the performance review 
itself. You have made it a Text subfield so that it can hold a substantial 
amount of text (up to 32,000 characters).

3. Click OK after creating the Comments subfield.

The three subfields are linked automatically to each parent record.

4. Using the same layout pattern (#5) you used for the previous input 
layouts, create an input layout for the Review Info subfile and name it 
“Input”. Use all three subfields.

5. After creating the layout, double-click the Comments field.

4th Dimension displays the Field Definition dialog box.

6. Select the Text with Scroll Bar check box.

7. Click OK.

This layout will be referred to later as a full-page layout because it provides 
access to a record on a full page.

8. Drag the layout frame down to just past 250 and increase the size of 
the comments field to accommodate paragraphs of text.
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9. With the Comments fields selected, press Ctrl+1 to draw a border 
around the expanded Comments field.

Now that you have created an input layout, you can proceed to create a 
layout for the [Employees] file that includes the layout for the subfile.

1. Create a new input layout for the [Employees] file and name it 
“Subfile”. Select the 9-point font size.

2. Select the First Name, Last Name, and Title fields from the 
[Employees] file.

3. Double-click the Review Info field and click the Select button.

4th Dimension lists the subfields in the Review Info subfile.

4. Select the Review Date, Rating, and Comments subfields.

You create an included layout area for a subfile in the same way you 
created an included layout area for a related file in Chapter 9. You select 
the subfile as one of the fields to be displayed and then select the fields 
you want from the subfile. 

Expanded 
Comments field
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Be sure your New Layout dialog box matches the one shown below before 
proceeding.

5. When you have finished, click OK.

4th Dimension creates a new layout that automatically includes a 
multi-line layout area for the subfields.

Whenever you enter information for an employee, you will see the subfile 
displayed in the subfile display area.

You now need to associate the subfile input layout with the included 
layout area.

1. Double-click the included layout area.

4th Dimension displays the Included Layout dialog box. You use this 
dialog box to tell 4th Dimension which of the subfile layouts to use for 
input.

The Review Info subfile name is highlighted. The asterisk next to the 
subfile name shows that Review Info is associated with the included 
layout area.

Included layout area 
for the subfields
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2. Click the Expand button to show the list of layouts you have created 
for Review Info.

3. Select the Input layout and click the Full Page check box.

This step makes the input layout the full-page layout that “waits behind” 
the subfile display area until you signal to enter more data. You will see 
this feature in action in the next section of this chapter. Ignore the 
buttons for the different frame displays. They are used only during 
printing.

4. Select the Double-clickable check box in the Data Entry area.

This step makes it possible to double-click the included layout. When the 
included layout is double-clicked, the full-page layout is displayed.

5. Click OK.

4th Dimension displays the layout on which you have been working.

6. Close the Layout editor window.

ENTERING INFORMATION INTO THE SUBFILE

Now that you have created the subfile and an [Employees] file layout with 
a subfile display area, you can use the new layout to enter and display 
information. In the following steps you will add review information to a 
record that already exists.

1. Choose User from the Use menu.

4th Dimension lists the employee records in the output layout.

2. Make the new layout, Subfile, the current input layout.

You change the current layout by choosing it from the List of Files 
window. To display the List of Files window, press Ctrl+Space bar.

3. Select the first record in the list of records.
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4. Choose Modify Record from the Enter menu.

4th Dimension displays the record, including the added subfile display 
area.

As you can see, the subfile display area uses a multi-line layout pattern.

5. Double-click anywhere within the subfile area.

4th Dimension displays the full-page layout for the Review Info file. This 
is what was meant by the Review Input layout “waiting behind” the 
subfile area.

6. Enter the following information for this employee:

Review date: “3/18/88”
Rating:“4.5”
Comments:“Tom has had a very successful quarter, meeting all his 
stated goals. In particular, his report on the need for the
new Engineering department was effective in getting it
established.

During the coming quarter, his goal is to establish budget
and scheduling parameters for the coming year. This
means he will be working directly with Marcy Strassman.”
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Notice that the text area for comments works like a text processor. The 
words wrap from line to line within the borders of the field area.

7. Click the Enter button.

4th Dimension displays a blank input layout for the subfile. Click the 
Cancel button to return to the parent record.

Although you can see only a few lines of the text you have entered, the 
text area contains all the words.

After you enter additional subrecords, you can move any of them into 
view with the scroll bar on the right of the subrecord display area.

8. Click the Enter button to return to the output layout.
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THE NEXT STEP

You have seen how to create a subfile in which you can store many pieces 
of information about an employee. The subfile can accommodate any 
number of subrecords. 

All of these reviews can be viewed on an employee’s record in an included 
layout area. In addition, information about an employee’s review can be 
entered directly into the Subfile layout using the included layout.
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Database: PEOPLE11
Estimated time to complete: 10 minutes

In this chapter you will learn how to use 4th Dimension’s Search editor to 
search for a group of records based on a set of search conditions.

In the 4th Dimension Quick Start you used the Search by Layout menu 
command to search for a specific record. When your search conditions are 
more complex, you use the Search editor. You would use the Search 
editor, for example, if you wanted to find all the records whose entry date 
field contains values between two dates.

In this chapter you will learn how to:

■ Enter search conditions in the Search editor,

■ Create complex search conditions,

■ Search on a field in a related file.
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USING SEARCH CONDITIONS

You often need to isolate a specific group of records to view them 
together, to update a field in each record in the group, to perform a 
calculation, or to print a report based on that subset of records. The subset 
of records isolated by searching is called the selection.

A search is based on search conditions, instructions to 4th Dimension that 
identify the basis on which the records are included or excluded from the 
selection. The current selection is made up of records that meet the search 
conditions.

Suppose you want to see all the records for employees with salaries greater 
than $30,000. The condition you would enter to isolate those records is 
“Salary greater than 30000.” 

This simple example illustrates both the nature of a search condition and 
the ease with which you can write search conditions in 4th Dimension. 
Using this search condition, 4th Dimension tests the condition against the 
value in the Salary field for each record. If the condition is true (the salary 
is greater than 30000), the record is included in the selection. If the 
condition is false (the salary is 30000 or less), the record is excluded from 
the selection.

A search condition always has three elements in this order: field name, 
operator, and value. The field name is from the current file or from a related 
file. The operator is a comparison, such as equal to, greater than, less than, 
and so on. The value is the value to which each record is compared. In the 
Search editor, the search condition is displayed in the text area so that 
you can easily view and edit it as necessary.

You can save search conditions or load conditions you have previously 
saved. If you need to perform the same search on a regular basis, 
4th Dimension allows you to enter the search conditions once, save them, 
and then have them available whenever you need them.

4th Dimension searches indexed fields more rapidly than non-indexed 
fields because it can use the index tables specially created for the fields to 
quickly find any matching records.
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USING THE SEARCH EDITOR

Suppose you want to see all records of people earning more than $30,000 
a year. You can create a selection of just these records using the Search 
editor.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE11 database.

PEOPLE11 opens in the User environment.

2. Choose Search Editor from the Select menu.

4th Dimension displays the Search editor in which you enter the 
condition you want to use to search.

3. Click Salary in the Field area.

4th Dimension enters the field name in the Criteria area.

4. Click “is greater than” in the Operator area.

5. Type “30000” in the Value line at the bottom of the dialog box.

This completes your search condition.

6. Click OK.

4th Dimension performs the search based on the condition you have 
entered. The records of all employees earning more than $30,000 are 
displayed on the screen.

7. To see all the records in the file again, choose Show All from the 
Select menu.

Criteria area

Field area

Operator area

Value line
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Using a Condition with And
You use the And conjunction to join two search conditions. The And 
conjunction restricts the search to fewer records than either condition 
alone. In order to meet the compound condition, a record must satisfy 
both conditions.

Suppose, to take a simple example, you want to view the record for Mary 
Smith. You can use And to create a compound search condition for this 
task. You want to see the record that has Smith in the Last Name field And 
that has Mary in the First Name field. The record selected must meet both 
conditions, not just one.

1. Choose Search Editor from the Select menu.

4th Dimension displays the Search editor. The previous search condition 
is still displayed in the editor text area.

2. Choose Clear from the Edit menu to erase the previous search 
condition.

3. Click Last Name.

4th Dimension enters the field name in the Criteria area.

4. Click “Is Equal To” in the Operator area.

5. Type “Smith”.

The first search condition is complete. So far your condition states that 
you want to see records that have a last name of Smith. You now need to 
enter the conjunction and add the second condition.

6. Click the And button.

This step prepares the editor to receive the second condition.

7. Click First Name, then click Is Equal To, and then type “Mary”.

Both conditions are complete.
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8. Click OK.

4th Dimension performs the search based on the conditions you have 
entered. The record you want is displayed on the screen.

Using a Condition with Or
You use the Or conjunction to join two search conditions. The Or 
conjunction expands the search to more records than either condition 
alone. In order to meet the compound condition, a record can satisfy 
either condition.

Suppose, for example, you want to see the records for several employees 
who have recently received social service awards of various kinds. You can 
join them into one compound search condition with Or.

Your conditions will state that you want to see records that have a Last 
Name entry of Davis, or Wilson, or Tracy, or Arnold, or Martin. In ordinary 
English you might say, “I want to see the records for Davis, and Wilson, 
and Tracy, and Arnold, and Martin.” However, you are writing logical 
conditions. Clearly no record contains Davis, Wilson, Tracy, Arnold, and 
Martin. Each record has just one of these last names. In this case, you need 
Or to expand the number of records that meet the condition.

1. Choose Search Editor... from the Select menu.

4th Dimension displays the Search editor again.

2. Choose Clear from the Edit menu to remove your previous search 
conditions.

4th Dimension clears the Search editor.

3. Click Last Name, click Is Equal To, and then type “Davis”.

4. Click the Or button.

5. Enter the condition “Last Name is equal to Wilson” and click the Or 
button again.

6. Continue using the Or condition for the remaining last names:

“Tracy”
“Arnold”
“Martin”

You have entered a five-part search condition joined with Or. A record can 
meet any of these conditions and be included in the selection. The 
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principle at work here is that using Or expands the number of records in 
the selection.

7. Click OK.

4th Dimension performs the search and displays the selection of records 
on the screen. Notice that the search was of the entire file, not of just the 
selection created by the previous search. 4th Dimension assumes you want 
to search the entire database. To search just the current selection, you 
would select the Search in Selection check box before you click the OK 
button.

NOTE: If you need to use a Search condition again, you can save the condition to a disk 
file by clicking the Save button. When you need to reuse the search condition, open the 
Search editor and click the Load button instead of entering the search condition 
manually.
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SEARCHING ON A FIELD IN A RELATED FILE

The [Employees] file is related to the [Departments] file. As you saw in 
Chapter 8, this means that every employee record has one corresponding 
department record. The relation allows you to perform searches of the 
employee records based on entries in the [Departments] file.

In this section you will perform two searches, the first on the department 
code and the second on the department managers name.

1. Choose Search Editor... from the Select menu.

4th Dimension displays the Search editor again. Your previous search 
condition remains in the Search editor.

2. Choose Clear from the Edit menu.

4th Dimension clears the Search editor.

3. Click either of the cycle arrows at the top of the list of fields until the 
[Departments] file is displayed.

NOTE: You can also change to the [Departments] file by pressing and holding down the 
mouse button between the cycle arrows. A drop-down menu of filenames appears, 
allowing you to choose the file to which you want to change.

4. Enter the search condition “Code is equal to ‘TRAN’”.

5. Click OK.

4th Dimension searches for the records in the [Employees] file that are 
related to the [Departments] record with TRAN in the Code field and 
displays them.

Cycle arrow
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You have searched on the department code to isolate all the records for 
members of the Transportation department. Suppose, however, you want 
to see the employees reporting to Mr. Wanamaker, but you do not know 
his department code. You can search on another field from the related 
file, not just the related field.

6. Open the Search Editor, clear it, and enter the search condition 
“Manager is equal to ‘Mr. Wan@’”.

You have used the “@” wildcard character so that you do not have to spell 
out the whole name.

7. Click OK.

4th Dimension searches for the records in the [Employees] file that are 
related to the [Departments] record with Mr.Wanamaker in the Manager 
field and displays them. These are all the employees who report to 
Mr. Wanamaker.
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THE NEXT STEP

The Search editor is designed to perform any kind of search, from simple 
searches to the kind of compound searches that are covered in this 
chapter to even more complex combinations of Or, And, and Except. 
Using the Search editor, you can create a search based on fields in the 
current file and on fields in any related files.

As you can see from the Select menu, using the Search editor is just one 
of four ways to search for records in a database. 

4th Dimension provides the Search by Layout editor which you used to 
perform a simple search for a record in the Quick Start manual. You can 
perform a more complex search in the Search by Layout editor by entering 
values in more than one field to generate a compound search. In addition, 
you can use special symbols such as “<” (the less than symbol) that allow 
you to qualify your search. 

You use the Search and Modify editor to search for a specific record that 
you want to modify. When the record you are searching for is found, 
4th Dimension opens the record in the input layout to allow you to make 
any necessary modifications.

4th Dimension also provides the Search by Formula editor. This editor is 
designed for searches based on formulas created using 4th Dimension’s 
built-in functions and commands. You would use Search by Formula to 
search on particular characters in a string (for example, the last seven 
characters of a Telephone number field) or on the results of arithmetic 
operations (for example, companies whose ratio of profits to sales is 
greater than a specified value). 

For more information about the Search, Search by Layout, Search and 
Modify, and Search by Formula editors, refer to the 4th Dimension User 
Reference.
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Estimated time to complete: 10 minutes

You often need various printed versions of the records in your database. 
You may need to print a list of names and phone numbers or create 
mailing labels. You might be called upon to prepare reports that present 
the information in several ways. With 4th Dimension, you have all the 
flexibility you need to perform these tasks.

In this chapter you will learn how to:

■ Create a quick report that includes subtotals,

■ Use fields from a related file in a report.
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USING THE QUICK REPORT EDITOR

Reports allow you to communicate the information contained in records. 
4th Dimension’s Quick Report editor allows you to print all the 
information, some of it, or just summaries of it (total sales for October, for 
example). You can design and save reports that you use again and again 
or you can quickly design a special report that you use only one time.

Using the Quick Report editor, you can design and print tabular reports 
quickly. You can choose the fields you want to print, arrange them in any 
order, calculate totals and subtotals, and print additional text. Here is a 
typical report:

This report was created by the following report design. The report design is 
the set of instructions that tells 4th Dimension what to print.

Header row

Totals row

Summary calculation 
at Break row

Detail rows contain information 
drawn from fields

Header row
Detail row

Break row
Totals row
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By comparing the report design with the final printed output, you can see 
that the Header row is shown at the top of the design and that it is printed 
at the top of the columns of field information. The Detail and Break rows 
appear in the middle of the design and affect the middle of the printed 
report. The Totals row is shown at the bottom of the design and is printed 
at the bottom.

DETAILS AND BREAKS

When your report is printed, 4th Dimension looks through the records in 
the current selection one at a time. The sort order determines the order in 
which the records appear in the report and how records are divided into 
groups.

The report design in this chapter sorts the records by Department. 
4th Dimension looks at all the records for one department, then at all the 
records for the next department, and so on. This sort order allows 
4th Dimension to calculate a subtotal for each department. If the records 
were sorted by job title, 4th Dimension could calculate a subtotal for each 
job title.

Whenever the value in the sort field changes, a break is generated. The 
word break comes from the idea of interrupting. When 4th Dimension 
comes to the end of the records for the Art department, a break occurs (an 
interruption in the sequence of Department entries). Before 
4th Dimension prints the first record in the next department, it performs 
whatever calculations you have instructed it to do.

Records can be sorted into many levels. If you sort the records by 
department and then by job title, you can create a break whenever the job 
title value changes as well as when the department value changes. You 
could therefore calculate additional subtotals for job titles within the 
department.

You must have at least as many sort levels as break levels. But you do not 
have to create a break level for every sort level. In the example in this 
chapter, there are two sort fields—Department Name and Last Name— 
but only one break level. The break level corresponds to the first sort field, 
Department Name. Therefore, records are broken up into groups using the 
Department Name field, but not the Last Name field. The Last Name field 
is used to sort records so that within each department the employees 
appear in alphabetical order.
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CREATING A QUICK REPORT

For this quick report, you will create a list of employees and their salaries, 
grouped by department. You plan to calculate the total salaries for all 
employees as well as subtotals for each department.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE12 database.

PEOPLE12 opens in the User environment.

2. Choose Quick from the Report menu.

4th Dimension displays the Quick Report editor.

In the next steps you will drag the fields from the field list into the Quick 
Report layout. Since the first field you want (Name) is in another file, use 
the cycle arrows at the top of the list to display the [Departments] file.

3. Click the right cycle arrow until the [Departments] filename is 
displayed in the box.

The [Departments] file fields are displayed in the Field list.

4. Drag the Name field from the Field list into the Quick Report layout 
area.

When you release the mouse button, 4th Dimension creates a column for 
department names.

Field list

Sort list

Quick Report
layout
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5. Click the left cycle arrow once to return to the [Employees] file fields.

6. Drag the Last Name field from the Field list and place it to the right of 
the Name column in the Quick Report layout.

4th Dimension creates a column for employees’ last names.

7. Drag the Salary field from the field list and place it to right of the Last 
Name column in the Quick Report layout area.

4th Dimension creates a column for employees’ salaries.

You now need to establish the sort order, both to determine the order in 
which the records will be printed and to allow you to create a break row. 
You will use Name and Last Name for your sort fields.

1. Drag the <<Add Sort>> phrase from the Sort list onto the Name 
column in the Quick Report layout area.

4th Dimension adds the Name field to the Sort list.

2. Drag the <<Add Sort>> phrase from the Sort list onto the Last Name 
column.

You have created a two-level sort. The primary sort field is the department 
name. Within each department the records are sorted by the employees’ 
last names.
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You want to have 4th Dimension calculate a total for salaries. You do this 
the same way as you did in the 4th Dimension Quick Start.

1. In the Salary column, select the cell intersected by the Totals row and 
click the Sum check box.

4th Dimension adds a sum symbol (∑) to the selected cell, instructing the 
program to calculate the total of all the salaries when the report is printed. 
The total will be printed in the Salary column.

2. Select the cell to the left of the calculated cell you just created, click 
again to create an insertion point, and type “Grand Total:”.

3. Choose Left from the Style menu.

You can now create a Break row so that you can instruct 4th Dimension to 
calculate a subtotal.

1. Select the Totals row by clicking on the “T” or by clicking in the Totals 
row to the right of the fields.

2. Choose Insert Break from the Edit menu.

4th Dimension creates a Break row just above the Totals row and adds a 
sum symbol to the Salary cell in the Break row. This action instructs the 
program to calculate the subtotal (all the salaries in the preceding 
department) when the report is printed. The same symbol is used for both 
summing operations (total and subtotal). The difference between the 
instructions depends on the row in which the Sum instruction is placed: 
placed in a Totals row, the Sum calculates over the entire report (totaling 
salaries for every record in the selection); placed in a Break row, the Sum 

Totals row

Sum check box

Salary column
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calculates over only the records printed since the previous break (totaling 
salaries for records in each department).

You can now add some additional text next to the subtotal. Placing the 
text in the Break row ensures that it will be printed each time the subtotal 
is calculated.

3. Select the cell to the left of the subtotal cell you just created, click 
again to create an insertion point, and replace the existing text with 
“Subtotal for: #”. 

The number sign, #, tells 4th Dimension to substitute the name of the 
department whose sum is being printed. For example, when 
4th Dimension prints the subtotal for the Engineering department, the 
label will read, “Subtotal for Department: Engineering.”

4. Choose Right from the Style menu.

The subtotal text is aligned right.

5. Click in the Detail cell in the Salary column, click again to create an 
insertion point, and type the format: “$#,###,###”.

This tells 4th Dimension how to format the employees’ salaries. This 
format will also be applied to the subtotals and the grand total.

6. Click in the Totals cell in the Last Name column, click again to create 
an insertion point, and type “Grand Total:”.

Here is your final report design:

Display format 
added to Detail line
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You are now ready to print your report.

1. Choose Print... from the File menu.

2. Select the Preview on Screen check box and click the Print button.

4th Dimension previews the report on the screen. You can click the Zoom 
button to examine the report more closely.

3. When you are finished examining the report, click the Stop Printing 
button and then click OK to quit.

You have created a useful report in just a few minutes. If you wanted to 
print such a report each month or each quarter, you could save this report 
and reuse it. To do so, you would simply load the report design and print 
it again. The printed output would reflect any changes you had made to 
the database in the meantime.
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THE NEXT STEP

The Quick Report editor can also print text at the top and bottom of each 
page, provide automatic page numbers, and apply any font, size, and style 
to text on the report. For complete information about using the Quick 
Report editor, refer to the 4th Dimension User Reference.

The Quick Report editor is one of 4th Dimension’s two major report 
methods. You can also design a report using the Layout editor. The Quick 
Report editor can handle many of your reporting needs, but not all of 
them. In Chapter 13, you will design a more complex report using the 
Layout editor.
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Database: PEOPLE13
Estimated time to complete: 45 minutes

One of the major functions of a database is to produce reports. In Chapter 
12 you used the Quick Report editor to create a report. In this chapter you 
will use the Layout editor to create a custom report.

There are several advantages to using a layout for a report: you can use 
graphic elements on the layout, control the placement of report elements 
precisely, use scripts to perform calculations, and use headers at each 
break. The advantage of the Quick Report editor is that you can use it to 
quickly create standard reports.

You will next create a report that shows the employees, their salaries, and 
the total salaries for each department. This report is similar to the quick 
report you produced in the previous chapter. Using the Layout editor, you 
will create separate header areas for each department.

In this chapter you will learn how to:

■ Create a report layout including header, footer, break header, detail, 
and break areas,

■ Print the time, date, and page number,

■ Create scripts that calculate subtotals and totals.

CREATING A CUSTOM REPORT LAYOUT 13
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REPORT LAYOUTS

Here is an example of a report produced from a layout:

The report lists the salaries of the employees in each department. The 
departments are listed alphabetically and the employees within each 
department are listed alphabetically by last name. 

The report contains the following areas:

■ Header area: This area contains the title of the report (“Consumer 
Products Employees”) and includes date and time stamps. 

■ Break Header areas: These areas contain the department names and 
provide headings for the column listings.

■ Detail areas: These areas contain information about each employee 
appearing in the report.

■ Break areas: These areas report the subtotal for each department. 

Break Header 
area

Header area

Detail area

Break area
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The following areas appear on the last page of the report:

■ Totals area: This area reports the grand total for all departments at the 
end of the report.

■ Footer area: This area contains the footer that appears on each page of 
the report.

Notice that the Break Header, Detail, and Break areas repeat for each 
department in the report. The Department field is called the break field 
because it causes a new section of the report to be generated when its 
value changes (from “Accounting” to “Administration”).

Here is the output layout for this report:

The areas of the report—the Header, Break Header, Detail, Break, and 
Footer—are controlled by the report control lines on the layout. The 
report control lines are in the ruler on the right.

You are familiar with these terms already:

■ Header (H): The header is printed at the top of each page.

■ Break Header (H1): A break header contains material that is printed 
once at the beginning of each break. This type of header is useful to label 
information at each major division of a report.

■ Detail (D): The detail area usually contains data that comes directly 
from each record. Whatever appears in the detail area on the report layout 
is printed once for each record.

■ Break (B1): A break area contains subtotals and other calculations 
performed during a break in the Sort field. You can specify what 
calculations you want performed and any additional text you want 
printed whenever a break occurs.

Break header

Detail
Break
Total

Footer

Header
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■ Total (B0): The total area usually contains subtotals and other 
calculations performed on all the records in the report. You can specify 
what calculations you want performed and any additional text you want 
printed. 

■ Footer: The footer is printed at the bottom of each page.

The report control lines define areas on the layout. The elements you 
place in each of these areas—fields, text, and variables—are printed at the 
appropriate places in the report. You can use scripts to perform any 
necessary calculations.

NOTE: The layout rulers are marked in pixels, which are the smallest dots your screen 
can display. The rulers can be changed to inches or centimeters by choosing Ruler Units 
from the Layout menu.

WORKING WITH REPORT CONTROL LINES

In Chapter 1 you created an output layout to display your records on the 
screen. This time, you will create an output layout designed for printing.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE13 database.

PEOPLE13 opens in the User environment.

2. Choose Design from the Use menu.

3. Create a new output layout for the [Employees] file named 
EmployeeReport.

Include these fields in this order: Last Name, Title, and Salary. Use the 
layout template in the upper-left corner of the pattern choices. Make sure 
your New Layout dialog box looks like this:
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4. Click OK.

The layout is displayed in the Layout editor.

5. Expand the window either by clicking the maximize button or by 
dragging the window.

6. To prepare to add elements to the report, drag the Footer line down 
to 230 and the Break line down to 150.

To move the line, drag the letter or the triangle of each line. A dotted line 
extends from each line across the layout to show the location of each area.

The Footer line, a triangle labeled F, shows the bottom of the Footer area. 
Anything you enter on the layout between the Footer line and the Break 
line will be printed at the bottom of each page of the report. You usually 
use footers for page numbers and running titles or comments.

The Break line, a triangle labeled B0, shows the bottom of the Break area. 
The Break area is equivalent to the Total (T) row in the Quick Report 
editor. B0 stands for the level zero break.

7. Hold down the Alt key and click the Break line.

The level one Break line, labeled B1, appears on top of B0.

8. Drag the B0 line down to 180.

Anything you enter on the layout between the B1 Break line and the 
Detail line will be printed each time the value in the sort field changes. 
You will sort the records before printing to create the necessary Sort field 
break.

NOTE: If you inadvertently create an extra Break line (B2, B3, and so on), you can delete 
it by holding down the Ctrl key as you click the unwanted letter or triangle of the line.

9. Choose Select All from the Edit menu. 

All of the elements are selected, allowing you to move them as a group.
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10. Drag all the elements so that the bottom line of the frame is at about 
120. 

11. Deselect the elements by clicking on the layout.

12. Format the Salary field with the $###,##0 format by 
double-clicking on the field and choosing the format from the Format 
drop-down list box.

13. Drag the Detail line down to just above the bottom line of the frame 
(just above 120).

The Detail line, a triangle labeled D, shows the bottom of the detail area. 
Anything you enter on the layout just above the Detail line will be printed 
once for each record in the selection you print. You use this area for data 
drawn directly from the records.

14. Drag the Header line until it is at 40.

The Header line, a triangle labeled H, shows the bottom of the header 
area. Anything you enter on the layout just above the Header line will be 
printed at the top of each page of the report. You usually use headers for 
the title of the report and date or time stamps.

15. Hold down the Alt key and click the Header line.

The level one Break Header line, labeled H1, appears.

16. Drag the H1 line just below the middle line of the frame and above 
the fields (just above 100).

The Break Header line, labeled H1, is at the bottom of the break header 
area. Anything you enter between the Break Header and Header lines will 
be printed once above each group of records. You will use this area to label 
each group of records and the columns of the report.

Bottom of frame Salary field
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17. Raise the top line of the layout box up to 50 and delete the two 
vertical bars inside the layout box that separate the fields.

18. Click the Add Field tool  and draw a rectangle in the upper-left 
corner of the layout box. 

The Field Definition dialog box appears. 

19. Select the Name field from the [Departments] file by double-clicking 
on the [Departments] file name and scrolling down the list of fields to 
Name. 

When you click OK, your report layout reappears. The name field appears 
where you placed it on the layout.

20. Make the field 12-point and bold.

You have now defined areas on your layout for elements to be printed in 
the Header, Break Header, Detail, Break, and Footer areas of your report. 
Anything entered in these areas prints at the appropriate time.

Top line

[Departments]
Name field
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WORKING WITH NON-ENTERABLE 
OBJECTS AND SCRIPTS

You worked with one type of active object in Chapter 2 when you added 
buttons to your layout. You will now use objects and scripts to perform 
tasks on this report layout.

1. Select the Last Name text area and change it to “Name”.

Use the Text Area tool  to select text within the text area.

2. Delete the Last Name field by selecting it and pressing the Backspace 
key. 

3. Replace the Last Name field with an active object.

To add an active object, you click the Active Object icon  and draw a 
rectangle where you want to place the object. You will name the object 
and add other instructions in the Object Definition dialog box.

You selected the Last Name field for inclusion only so that the layout 
would provide room for this object. In its place, you are going to write a 
script for the object that joins each employee’s first and last names.

4. In the Object Definition dialog box, type “vName” for the name, select 
the Non-enterable object type, and deselect the Script Only if Modified 
check box.

Be certain to deselect the Script Only if Modified check box. Script Only 
if Modified applies only to an input layout. If you leave it selected, the 
script will not execute when the report is printed.

5. Click the Script button and select the Listing type for the procedure. 
Enter the following one-line procedure:

vName:=Last Name+", "+First Name

This script instructs 4th Dimension to print the value from the Last Name 
field, then a comma and a space, and then the value from the First Name 
field. This is better than using two fields on the layout because the comma 
and the first name come immediately after the last name. Two fields 
would leave extra spaces after most last names.
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6. Double-click the Control-menu box to close the procedure.

7. Make vName 12-point.

The vName variable is in the Detail area of the report. It will be processed 
and printed once for each record you print. The script you have written 
will cause the report to include the last and first names for each employee.

Now you will work on the header of the report.

1. In the Header area above the column headings, create a large text 
area and enter a report title: “Consumer Products Employees”. Set the 
font and size of the title to Helvetica 18 and make it bold.

2. Create a text area and type “Date:”.

3. Create an active object, name it “vDate”, and make it a 
non-enterable object. Deselect the Script Only if Modified check box and 
select Short from the Format drop-down list box. 

4. Click the Script button and enter the following script:

vDate:=Current date

This script instructs 4th Dimension to print the current date in the object.

5. Create a text area and type “Time:”.

6. Create an active object, name it “vTime”, and make it a 
Non-enterable object.

7.  Deselect the Script Only if Modified check box and use the HH:MM 
AM/PM format. 

8. Click the Script button and enter the following script:

vTime:=Current time

This script instructs 4th Dimension to print the current time in the object.
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Your layout should now look like this:

Next, you will create the break area of the report, where the salaries are 
subtotaled.

1. In the B1 Break area (between the Detail line and the B1 Break line), 
create an active object for the salary subtotal. 

2. Make the object the same size as the Salary field above it and name 
the object “vSalarySub”. 

See the figure on the next page for placement.

3. Make vSalarySub a non-enterable object, deselect the Script Only if 
Modified check box, and enter “$#,###,###” as the numeric display 
format.

4. Click the Script button and enter the following script:

vSalarySub:=Subtotal(Salary)

The Subtotal function instructs 4th Dimension to calculate the total for the 
current break. Because the object is located in the B1 Break area, 
Subtotal will calculate a subtotal for each department. 

The portion of the script in parentheses is called the argument for the 
Subtotal function. It instructs 4th Dimension to use the Salary field for the 
subtotals.

The Subtotal function is necessary for creating a report with an output 
layout. In order to generate a layout report with breaks (i.e., to print break 
headers, the records under each break header, and the elements in the 
break areas), you must activate break processing somewhere in your 
layout. 

Placing the Subtotal function somewhere in your output layout is the 
simplest method of activating break processing. For complete 

Elements added in 
the Header area
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information about activating break processing, refer to the 4th Dimension 
Language Reference.

5. Make vSalarySub 12-point. 

6. Create a text area to the left of vSalarySub.

An insertion point appears in the text area. 

7. Type the following label: “Total Salaries for”.

Be sure to press the Space bar after typing the label.

8. While holding down the Shift and the Alt keys, press and hold down 
the mouse button.

A drop-down menu appears.

9. Choose the Name field in the [Departments] file from the drop-down 
menu.

4th Dimension appends the Name field to the text. When you print the 
report, the name of the department is inserted where the 
<[Departments]Name> phrase appears in the output layout.

NOTE: You can use this technique of embedding the values of fields in text areas in other 
kinds of reports. For example, you can create a mail-merge letter using one large text area. 
For more information, refer to the 4th Dimension Design Reference.



CREATING A CUSTOM REPORT LAYOUT 13-12

10. Choose 12-point and Right from the Style menu.

The text area should now look like this:

Next, you will create a place in the report to display the grand total of all 
the salaries.

1. Create an active object in the B0 Break area to calculate the total 
salaries.

The active object, named “vSalaryTot”, can be created by duplicating 
vSalarySub, and then editing the name and the script. The script to 
calculate the total is as follows:

vSalaryTot:=Subtotal(Salary)

The Subtotal function instructs 4th Dimension to calculate the total for the 
current break. Because the object is located in the B0 Break area, the 
Subtotal will calculate the grand total for all records.

Before closing the Object Definition dialog box, be sure to deselect the 
Script Only if Modified check box and give vSalaryTot the display format 
“$#,###,###”.

Object to calculate 
subtotal

Field name inserted 
in text area
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2. Create a text area to the left of vSalaryTot and type “Total Salaries for 
Company”. 

3. Choose 12-point and Right from the Style menu.

The report layout should now look like this:

Finally, you will create a footer for the report that will be printed at the 
bottom of each page.

1. In the left side of the Footer area (between the B0 Break line and the 
Footer line), create a text area and enter a running title: “Salaries by 
Department”.

This running title will print at the bottom of each page of the report.

2. On the right side, create a text area and type: “Page:”.

3. Create a non-enterable active object to contain the page number. 
Name this object vPage and deselect the Script Only if Modified check 
box.

4. Click the Script button and enter the following script:

vPage:=Printing page

This script causes 4th Dimension to print the page number.

Object to calculate 
grand total
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This figure shows the completed report layout. Make sure your layout 
looks similar to the layout shown here before you continue.

PRINTING THE REPORT

You have created the layout, objects, and scripts for your report. You can 
now see the result.

1. Choose User from the Use menu.

2. Choose Sort Selection from the Select menu and sort the records by 
[Departments] Name and [Employees] Last Name.

Use the cycle arrows to choose the [Departments] Name field.

You can sort the records in the [Employees] file by a field in the 
[Departments] file because the two files are related.

This sort order is required so that a break is generated after each 
department. Since you are using the Subtotal function to activate break 
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processing in your layout, 4th Dimension requires that you sort on at least 
one more sort level than break level. In this case, you are using two sort 
levels so that the names that appear within each department are in 
alphabetical order.

4th Dimension requires that you sort on at least one more sort level than 
break level in order to activate break processing using the Subtotal 
function.

For more information about the Subtotal function, refer to the 
4th Dimension Language Reference.

3. Click the Sort button. 

You are now ready to print your report.

4. Choose Print... from the File menu.

The Print File dialog box appears. Here you choose which layout you want 
to use to print.

5. Select EmployeeReport, the layout you just designed, from the list of 
layouts.

6. Click OK.

Two printer instruction dialog boxes appear, one after the other. If you 
have a printer connected to your computer, you can print your report. 
Click the Preview on Screen check box on the second dialog box to send 
your report to the screen instead.

7. Click OK.

8. Click the Zoom button to see the report close up.

You have created a working report. The scripts perform the necessary 
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calculations for subtotals and totals. They display the proper department 
name for each subtotal as well as the date, time, and page number of the 
report. You can view the third page of the report to see that the text for 
the grand total is also correct.

THE NEXT STEP

You have created a report layout and printed a report with it. The Layout 
editor gives you more power and flexibility in designing a report than the 
Quick Report editor, but it can take longer to design the customized 
report.

In the next chapter, you will learn how to further customize your 
database by adding custom menus that automate actions commonly 
performed by users. One of the menu commands you will create will 
allow users to generate the report you created in this chapter at any time, 
using current data from your files.
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Estimated time to complete: 15 minutes

You can create your own Windows applications, called runtime 
applications, using 4th Dimension. You can work with a runtime 
application in 4th Dimension’s Runtime environment or use it as a stand-
alone application that you run with a special Runtime version of 
4th Dimension.

A runtime application uses many elements you are already familiar with 
such as fields, choice lists, objects, scripts, formats, procedures, and 
layouts. To create a runtime application, you combine these elements 
with custom menus.

In this chapter you will learn how to:

■ Create custom menus,

■ Add a unique graphic background to an application.
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RUNTIME APPLICATIONS

A runtime application is an extension of a database. With a runtime 
application, you create the files, fields, and layouts you need. You then 
complete the application by adding customized menus and procedures 
that control the database. You use input layouts for the user to enter data, 
output layouts to display data, and reports for printing data.

Menu commands and procedures allow the user to perform the 
operations that you provide such as searching, sorting, and graphing. 
Your procedures can use the same editors used in the User environment. 
You can use the 4th Dimension Search and Sort editors, the Quick Report 
editor, the Graph editor, and the Label editor. 

You can also create more functions than the User environment offers. For 
instance, you can add a special search dialog box that performs exactly 
the search you want with just a click of the mouse button.

You can make a simple program that accepts information and stores it in 
records. Or, you can make a multi-functional program that includes some 
of the features with which you have already worked: data validation, 
reports, sorting, searching, and so on. You can create an application that 
includes several different reports, the ability to add, modify, and delete 
information, and the option to send the output to desktop publishing 
programs.

If you have a multi-user setup (several PC clients connected to a 
4th Dimension server), you can create a program that users in different 
departments each use with different access privileges. The manager of the 
Accounting department might be able to display information from any 
file in the database, while an order entry clerk might be able to see and 
use only one layout in a single file.

You can create programs that take advantage of the whole range of 
Windows interface features—windows, menus, custom dialog boxes, and 
so on. 
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4th Dimension allows you to create custom menus to operate your 
runtime application. You can display different menu bars at different 
times in your application to provide different menu choices.

A menu bar is one set of menus. You can have several menu bars for your 
application, each with different menus. Each menu bar can have as many 
menus as can fit across a screen and each menu can have as many menu 
commands as there is room for in a screen.

When chosen, each menu command calls a procedure to carry out the 
menu command. For instance, if a user chooses the Add Employee menu 
command from the menu bar above, 4th Dimension executes the 
procedure connected to it—a procedure that opens up an input layout to 
allow the user to enter data. 

In this chapter you will create menus and menu commands. In the next 
chapter you will create procedures for two of the menu commands you 
create in this chapter.

For this tutorial example, you will create menus for a runtime application 
based on the database you have been working with in the previous 
chapters. This application performs information tracking for your 
employees and includes reports that you provide for your company each 
month and each quarter.

Suppose you decide that your personnel application needs the following 
menus and menu commands:

File Departments Employees Reports
Quit Add Department Add Employee Monthly

Modify Department Modify Employee Quarterly

Remove Department Remove Employee
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Getting to the Menu Editor
To create these menu titles and menu commands, you use 
4th Dimension’s Menu editor.

1.  If you have not done so already, start 4th Dimension and open the 
PEOPLE14 database.

PEOPLE14 opens in the Design environment. 

2. Choose Menu from the Design menu.

4th Dimension displays the Menu Bars dialog box.

This dialog box will eventually list all the menu bars you create for this 
database. You can then select the one you want to modify. Because this is 
your first custom menu, the menu bar display area is blank.

3. Click the New button.

4th Dimension displays the Menu editor window, entitled Menu Bar #1. 
You cannot change this name.

On every menu bar, 4th Dimension automatically enters the File menu as 
the first menu. It contains one menu command, Quit.



CREATING CUSTOM MENUS

CREATING CUSTOM MENUS 14

14-5

Notice that the File menu appears in italics. The File menu is italicized 
because 4th Dimension retrieves the text for the menu title from a string 
resource. For the purposes of this tutorial, you do not need to know 
anything about string resources. The only thing you need to know is that 
when you select the File menu (as you will in the next step), the number 
of the string resource used for the menu (:79,1) appears in its place. For 
information about using string resources for menus and menu commands 
in your own databases, refer to the 4th Dimension Design Reference. 

4. Select the File menu title.

As you can see, the Menu editor displays the menu commands in the 
selected menu to the right of the menu title in the Items list. In this case, 
there is only one menu command, Quit, and there is no procedure. The 
absence of a procedure tells 4th Dimension to quit the application. 

It is always a good idea to leave the Quit menu command on the File 
menu because that is where users expect it to appear.

5. Pull down the File menu on the far right side of the screen.

The menu preview shows the order and style of the menu commands on 
the selected menu. Later you will preview the menus you create.

Entering Menu Titles and Menu Commands
You create the menus you want by entering the menu titles in the Menus 
column in the order you want them to appear. You then enter the menu 
commands for each menu in the Items column. For each menu command 
(except Quit), you enter a procedure name in the Procedures column. If 
you do not enter a procedure name, 4th Dimension will automatically 
return to the User environment.

The menu titles you create appear across the top of the screen in your 
application. 4th Dimension automatically shows the Edit and Help 
menus.

1. Choose Append Menu from the Menu menu.

A blank box containing an insertion point appears in the Menus column.
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2. Type “Departments”.

This is the first of your custom menu titles. You will enter the menu 
commands for this menu later.

3. Double-click in the Menus column just below the Departments menu 
title.

Double-clicking creates another menu title box, just as if you had chosen 
Append Menu again.

4. Type “Employees”.

5. Double-click below this menu title to create another blank menu title 
box.

6. Type “Reports” and this time press the Enter key.

Pressing Enter also creates another blank menu title box.

You have now finished entering your custom menu titles. You can go on 
to enter the menu commands for each title and the procedure name for 
each menu command. 

7. Select the Employees menu title. 

Use the scroll bar to move this menu title into view, if necessary, before 
selecting it. 
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8. Choose Append Item from the Menu menu. 

A blank menu command box appears in the Items column and a blank 
procedure box appears in the Procedures column. 

4th Dimension always adds both these boxes at the same time because 
each menu command must have a procedure entered in the Procedures 
column. 

9. Type “Add Employee” in the menu command box and press the Enter 
key. 

The insertion point moves to the procedure box. 

10. Type “Add Empl” and press Enter. 

Add Empl is the name you will give the procedure to add an employee 
record to the database. 

Another menu command box and procedure box are added on the next 
line. 

For each menu command, you type in the menu command as you want 
it to appear and then enter a procedure name. You can use any procedure 
name you want. 

11. Complete the menu bar by adding the following menu commands 
and procedures.

You will use these menus and menu commands in the next chapter.

Menu Menu Command Procedure
Departments Add Department Add Dept

Modify Department Mod Dept

Remove Department Remove Dept

Employees Add Employee Add Empl

Modify Employee Mod Empl

Remove Employee Remove Empl
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When you have finished, the menus look like this: 

Changing the Style and Adding a Shortcut
On the lower half of the Menu editor window are menu commands to 
change the look and function of a menu command. Users of this 
application will most often choose the Add Employee menu command. 
You can add a keystroke to activate the menu command as well. 

1. Select Add Employee. 

2. Select the Keyboard check box. 

You want this menu command to be accessed by a keystroke as well as by 
choosing the menu command from the menu. You want the keystroke to 
be Ctrl+N.

3. Select the Keyboard entry box and type “N”. 

4th Dimension will automatically insert “Ctrl+”.

Reports Monthly Monthly Rep

Quarterly Quarter Rep

Menu Menu Command Procedure



CREATING CUSTOM MENUS

CREATING CUSTOM MENUS 14

14-9

4. Preview the menu display by pulling down the menu preview on the 
far right of the menu bar. 

You have now made it possible to use the Ctrl+N keystroke combination 
to start the procedure that allows a user to add an employee record to the 
database. 

Note that there are three additional check boxes on the bottom of the 
Menu editor, Enabled, Line, and Start a New Process. Menu commands 
are enabled by default when you enter them in the Items list. If you want 
to disable a menu command, select the menu command and deselect the 
Enabled check box. The menu command appears dimmed in the menu 
and remains disabled until you select Enabled again. 

You can enter a line between menu commands by creating a blank box 
between the menu commands in the Item list and then clicking the Line 
check box. This feature allows you to effectively separate menu 
commands into groups of menu commands for the convenience of the 
user, as is done in the standard Windows Edit menu.

You use the last check box, Start a New Process, to tell 4th Dimension to 
start a new process when a menu command is chosen. By having menu 
commands execute within different processes, you can create a multi-
tasking system within your database that allows you to perform multiple 
operations at the same time. In the next chapter, you will use this check 
box to enable you to display a selection of records and a graph at the same 
time.

The Access drop-down list box at the bottom of the Menu editor allows 
you to control which group of users can use a specific menu command. 
Creating access groups for a password access system is covered in 
Chapter 17.
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PREVIEWING THE MENUS AND ADDING A GRAPHIC

You use 4th Dimension’s Menu editor to preview your menu bar and to 
paste a picture to display with it.

1. Choose Show Custom Menus from the Menu menu. 

4th Dimension displays the menu bar you have just designed. 

2. Pull down the Employees menu that you have just created. 

Choosing a menu command from this screen does not activate the menu 
command (and it wouldn’t activate it even if you had already written the 
procedure). You must be in the Runtime environment to start a menu 
command from a custom menu. 

If you have a picture in your Clipboard, you can paste it here. This picture 
will be displayed each time this menu bar is shown in the Runtime 
environment. You can use this feature of 4th Dimension to personalize 
your database applications with designs, patterns, and pictures that suit 
the company, person, or department that will be using the application. 

3. Click anywhere in the screen below the menu bar to return to the 
Menu editor. 

4. Double-click the Control-menu box to close the Menu editor and 
return to the Structure window.
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THE NEXT STEP

In this chapter you have seen how to create and preview a set of custom 
menus and menu commands for use in the Runtime environment. 
Proceed to the next chapter to learn how to create the global procedures 
that are called by these menu commands.

It does not matter in what order you create the custom menus and the 
procedures they use. You can write the procedures first or create the 
menus first. In the case of the Add Employee, Monthly, and the other 
menu commands in this chapter, you created the menu commands before 
the procedures. 

You now need to give the correct name to each procedure you create. If 
you wish, you can keep the Menu editor window open on the screen 
when you name the procedures in order to see which name you have 
used.
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If you want to use the Runtime environment or the Runtime version of 
4th Dimension, you need to create custom menus to add and modify 
records, search, sort, print, and so on. To associate these operations with 
menu commands in your application, you attach global procedures that 
perform the actions when menu commands are chosen. 

To write the procedures, you use the commands and functions in the 
4th Dimension language. Perfectly suited for creating runtime 
applications, the language is both simple enough to allow you to easily 
perform basic database operations and comprehensive and flexible 
enough to allow you to control every aspect of your application. 

In this chapter, you will create procedures to:

■ Add records,

■ Search for records,

■ Print a report.

In addition, you will learn how to perform more than one operation at a 
time by starting a new process when a menu command is chosen

This tutorial is based on the menu structure you created in Chapter 14. 
You will write three of the procedures you specified in Chapter 14. After 
you write these procedures, three of the menu commands you created in 
Chapter 14 will work.
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PROGRAMMING IN 4TH DIMENSION 

A series of statements that tell a computer what to do is called a program. 
In 4th Dimension, a series of statements is called a procedure. When you 
write procedures for 4th Dimension runtime applications, you can choose 
from over 300 commands in the 4th Dimension language.

The 4th Dimension language is a high-level language, that is, one 
command in the language performs a series of actions within the 
computer. The ADD RECORD command, for example, automatically 
performs all the steps necessary to display an input layout and accept the 
record when you click OK. 

4th Dimension’s language has many components in common with other 
programming languages, such as the following:

■ Tests: Conditions that are evaluated so that the program knows what 
to do next. 

■ Loops: Statements that require the program to repeat an action until a 
test is evaluated as true. 

■ Parameters: Pieces of information given to a procedure so that it 
knows what to do or what to act upon.

■ Functions: Statements that result in a value (a number, date, time, or 
series of characters) that can be used by the program. A function returns 
a value.

■ Commands: Statements that instruct the program to do something. 
For example, ADD RECORD is a command.

4th Dimension functions and commands are called routines. The routines 
available in 4th Dimension appear in a list so that you can place them in 
a procedure by clicking.

A complete discussion of programming with 4th Dimension is beyond the 
scope of this book. Further information can be found in the 4th Dimension 
Language Reference.
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CREATING A GLOBAL PROCEDURE

You are now going to write the procedure to add an employee record to 
the database. This is the procedure you named Add Empl in the previous 
chapter.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE15 database.

PEOPLE15 opens in the Design environment.

2. Open the Procedure editor and create a new global procedure called 
Add Empl.

If you need to review the beginning steps for creating a procedure, see 
Chapter 7, “Using Procedures.”

4th Dimension displays the Procedure editor in a window entitled 
“Procedure: Add Empl.” You use the Procedure editor to write and edit 
procedures.

You can most easily learn how to write 4th Dimension procedures by 
carefully considering what the program needs in order to work. Here are 
the most important points to keep in mind:

■ A global procedure is executed from beginning to end, from the first 
line to the last line of the procedure (when the last statement has been 
executed, the procedure stops running).

■ Since a database can have more than one file containing records, you 
need to specify the file on which commands operate.

■ Since each file can have several layouts, you need to specify which 
layout to use.

Procedure text 
area
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To instruct 4th Dimension to add a new record, you will use the 
ADD RECORD command and specify the [Employees] file and the Empl 
Input layout. 

In Chapter 7 of this manual, you saw how 4th Dimension allows you to 
enter commands and other elements of a procedure by selecting them 
from the three panels on the bottom portion of the Procedure editor. You 
can select the filenames, field names, and layout names that appear in the 
center panel, the keywords that appear in the left panel, and the routines 
that appear in the right panel.

The following steps do not specify whether to select or type the elements 
of the procedure. You will decide which method works best for you.

3. Type the following comment to identify the purpose of the procedure:

`The Add Empl procedure adds a record to the Employees file

The leading accent mark indicates that this is a comment and not part of 
the instructions. The accent mark appears in different places on different 
keyboards. Do not confuse this accent mark with the apostrophe or 
backslash.

4. Press the Enter key on the keyboard (not the one on the numeric 
keypad).

When you press Enter, the comment is entered and automatically 
indented. The insertion point moves to the next line.

5. Define the file and input layout you want to use by entering the 
following code:

INPUT LAYOUT ([Employees]; "Employee Input")

Employee input is the name you gave the input layout you designed 
earlier in this manual. The layout names appear at the bottom of the list 
of fields in the file panel.
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If you should omit any necessary part of a command, 4th Dimension 
displays large dots on either side of the incorrect statement. The following 
figure shows 4th Dimension flagging an error in the first line of code. This 
error is caused by the absence of parentheses around 
“[Employees]; "Employee Input" .”

When you correct the statement and press the Enter key on the keyboard 
(or move the insertion point to a new line), the dots are removed.

6. Enter the following command:

ADD RECORD ([Employees])

This command displays an input layout for the specified file so you can 
add a record.

Dots indicate error
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SEEING THE PROCEDURE IN ACTION

Now that you have a procedure that can be called by a menu command, 
you can use the Runtime environment to see how it works.

1. Choose User and then Runtime from the Use menu.

You cannot enter the Runtime environment directly from Design 
environment using the Use menu. You must switch first to the User 
environment and then to the Runtime environment.

When you enter the Runtime environment, the menu bar you have 
created is displayed. If you pasted a graphic to this screen from the Menu 
editor, the Runtime window displays it too.

2. Choose Add Employee from the Employees menu.

The input layout you specified in the procedure is displayed.

3. Type some practice information and click the Enter button.

The initial screen reappears. The record has been accepted just as if you 
had entered it in the User environment. Your procedure works fine.

However, there is still some work to do. Typically, you would be adding 
several records to the employee file at the same time. As it stands now, 
your application returns to the starting screen after you enter each record. 
In the next section, you will alter your global procedure slightly so that it 
keeps the input screen active until you have finished entering records.

4. Choose Quit from the File menu.

4th Dimension returns to the User environment. Quitting from the 
Runtime environment returns control to the User environment. The 
record you have entered is displayed.

5. Choose Design from the Use menu.
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MODIFYING THE PROCEDURE

The Add Empl procedure you have written works fine for adding a record to 
the correct file. However, if you have three records to add, you have to 
choose the menu command three times. With a slight modification of the 
procedure, you can leave the input layout on the screen until you have 
finished entering as many records as you want.

This modification requires that you write a loop for the ADD RECORD 
command, making the command active until you click the Cancel 
button. This loop is called the While loop. Essentially, it requires 
4th Dimension to repeat a series of commands while a test is satisfied. The 
following steps show you how to edit the procedure you have already 
written.

1. Choose Procedure:Add Empl from the Design menu.

2. Click just to the left of the ADD RECORD command to move the 
insertion point to that spot.

3. Enter “OK:=1” and press the Enter key on the keyboard.

This statement sets the initial value of the OK variable, discussed later in 
this section.

4. Enter “While (OK=1)” and press the Enter.

4th Dimension automatically indents the ADD RECORD command. The 
indentation means that the command has moved down one level and 
will be executed only under the control of the loop that will surround it.

5. Move the insertion point to the line below the ADD RECORD command.

You can either click the mouse button to move the insertion point or use 
the down arrow on your keyboard.

6. Enter “End While” and press the Enter.

This step completes the loop. The meaning of the loop you have inserted 
in the procedure is that 4th Dimension must enter the loop at least once 
and repeat the ADD RECORD command as long as the OK or Enter button 
has been pressed (OK=1). Not until you click the Cancel button will the 
ADD RECORD command stop repeating. Clicking the Cancel button sets 
the OK variable to 0 (zero).

The OK variable is a variable that 4th Dimension creates automatically. 
You can use it in any procedure to test whether a user has clicked the 
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Cancel button.

7. Return to the Runtime environment to see the difference this loop 
makes to the task of entering records.

The input layout remains displayed and ready to accept additional 
records until you click Cancel (OK=0).
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USING THE SEARCH EDITOR IN AN APPLICATION

You have several more procedures to write before your application is 
finished. In this section you will see how to bring the Search editor from 
the User environment into your own application. You will use the Search 
editor as part of the Mod Empl procedure.

The steps described here show you how to create a procedure that does the 
following:

■ Displays the Search editor to create a selection of records,

■ Displays the selection as a list from which you can select records to 
modify.

1. Return to the Design environment and create a global procedure 
called Mod Empl.

The steps for creating a procedure are explained earlier in this chapter. Mod 
Empl is the procedure name you entered for Modify Employee in the 
previous chapter.

2. Type the following comment for your procedure:

`The Mod Empl procedure displays a selection of records

3. Indicate the file and input layout to use by entering the following:

INPUT LAYOUT([Employees];"Employee Input")

Now you want to instruct 4th Dimension to use its own Search editor.

4. Press the Enter key on the keyboard and enter the following 
command:

SEARCH ([Employees])

The SEARCH command, without any search parameters, displays the 
Search editor. 4th Dimension will use the search conditions that you enter 
in the Search editor to create a selection of records.

5. Instruct 4th Dimension to display the selection of records and prepare 
to modify those selected by entering the following command:

MODIFY SELECTION ([Employees])

This command allows you to modify the records in the selection. To 
display a record in the input layout, the user simply double-clicks on the 
record that needs to be modified.
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Before continuing, make sure that your procedure looks like the one 
shown below.

6. Now return to the Runtime environment to see how this command 
works.

When you choose Modify Employee from the Employee menu, the 
Search editor is displayed. You use the Search editor just as you used it in 
the User environment. After you enter the search conditions to isolate the 
records you want to modify and click OK, 4th Dimension displays the 
selection of records.

CREATING THE REPORT PROCEDURE

In this section you will see how to write a procedure that sorts records and 
then print them for a monthly report. You will use the report layout you 
designed in Chapter 13.

1. Return to the Design environment and create a global procedure 
called Monthly Rep.

The steps for creating a procedure are explained earlier in this chapter. 
Monthly Rep is the procedure name you entered for Monthly in 
Chapter 14.

2. Indicate the file and report layout to use by entering the following:

OUTPUT LAYOUT([Employees];"EmployeeReport")

3. Enter the following command to make the selection include all the 
records in the database:

ALL RECORDS ([Employees])

4. Sort the records by entering the following:

SORT SELECTION([Employees];[Departments]Name;>;[Employees]Last Name;>)
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SORT SELECTION is a very powerful command in 4th Dimension. It can be 
used to sort a selection based on fields you specify in the argument to the 
command or to sort based on fields you enter in the Sort Selection dialog 
box. 

Here, you have instructed 4th Dimension to sort the records in the 
[Employees] file according to the department name in the [Departments] 
file and then by the employee’s last name. Note that you first specify the 
name of the file you want to sort; you then specify the filename for each 
sort field. 

The greater than sign (>) instructs 4th Dimension to perform an ascending 
sort.

You need to sort the records because the report you are printing calculates 
subtotals for each department. Therefore, the records must be sorted by 
department before printing. You must sort on at least one more level than 
the number of breaks you are using. In this case, you are sorting on two 
levels and using only one break level.

5. Instruct 4th Dimension to print the selection of records by entering 
the following:

PRINT SELECTION ([Employees])

This command prints the selection, just like the Print menu command in 
the User environment.

6. Restore the output layout by entering the following:

OUTPUT LAYOUT ([Employees];"Employee List")

This command instructs 4th Dimension to use the previous output layout 
to display the records.

7. Return to the Runtime environment and see how the command works 
by choosing Monthly from the Report menu.

4th Dimension sorts the records and prints the report you have designed.
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CREATING PROCESSES WITH MENU COMMANDS

4th Dimension allows you to create a multi-tasking system—a system in 
which more than one operation can take place at the same time—by 
performing database tasks within separate processes. A process can be 
thought of as another 4th Dimension environment that executes 
whatever commands you give it. 

A process can open a layout, print a report, display a selection, display 
menus and windows, and so on. Basically, anything that can be done 
with the 4th Dimension language can be done in a process.

By opening more than one process at a time, you can perform more than 
one task at a time. 

One way to open a process for an operation is to start a new process when 
a menu command is selected. When you select the menu command, the 
global procedure attached to it executes within a separate process. Since 
the procedure is executing in a separate process, you are free to continue 
working with your database.

In this section, you are going to tell 4th Dimension to start a new process 
when the Graph menu command is chosen. The Graph menu command 
and its global procedure, Graphing, have already been created for you. 

1. Return to the Design environment by double-clicking the Control-
menu box of the main 4th Dimension window, and then choose Design 
from the Use menu.

You cannot move directly from the Runtime to the Design environment. 
You must first enter the User environment and then go to the Design 
environment.

2. Choose Menu from the Design menu and open Menu Bar 1.

Menu Bar 1 is displayed in the Menu editor.

3. Select the Reports menu.

The menu commands and procedures for this menu appear to the right.
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4. Select the Graph menu command and select the Start a New Process 
check box.

When this menu command is chosen in the Runtime environment, 
4th Dimension executes the Graphing procedure in its own process.

You are now going to switch to the Runtime environment to test out your 
process.

5. Return to the Runtime environment by choosing User and then 
Runtime from the Use menu.

6. Choose Graph... from the Reports menu.

The Search editor appears.

7. Enter the search criteria “Total Salaries, is less than or equal to, 
1000000” and click OK.
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4th Dimension finds the records of all departments whose total salaries are 
less than or equal to $1,000,000 a year and graphs their total salaries in a 
separate window. 

Feel free to open the Graphing procedure in the Design environment to 
find out how this graph was created. Descriptions of all of the commands 
in the Graphing procedure can be found in the 4th Dimension Language 
Reference.

THE NEXT STEP

You need to write a global procedure for each menu command you use in 
your runtime application. With 4th Dimension’s procedural language, 
you can create programs with great power and flexibility that allow you 
to control the processing of your information. 

In addition, you can enhance information processing by performing tasks 
in separate processes. This allows you to perform multiple operations at 
the same time, such as displaying a graph of your data in one window 
while you continue to choose other menu commands to perform other 
tasks.

This chapter has introduced you to one of the most powerful features of 
4th Dimension. For complete information about all the commands 
available in 4th Dimension, refer to the 4th Dimension Language Reference.
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In the last chapter, you created several global procedures that were 
attached to menu commands. When you chose the menu commands in 
the Runtime environment, the procedures executed and performed 
certain actions—in other words, each of the procedures worked.

Suppose, however, that you create a procedure that does not work or does 
not produce the results that you expected. You have an error in your code, 
otherwise known as a bug. 

Using the 4th Dimension debugger, you can easily locate and correct bugs 
in your code. Instead of puzzling over the procedure, you can use the 
debugger to execute the code line by line and determine what is 
happening at each step of the procedure.

In this chapter, you will learn how to:

■ Enter and use the Debug window,

■ Step through a procedure, executing it one line at a time,

■ Use 4th Dimension functions to analyze the code.
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DEBUGGING CODE

When you execute a procedure that has errors, or bugs, one of two things 
may happen:

■ The procedure stops executing and the Syntax Error window appears.

■ The procedure continues to execute but does not bring about the 
expected results.

In the first case, the Syntax Error window appears because of the incorrect 
usage of a command or function, known as a syntax error. When the 
Syntax Error window appears, you have the option of editing the 
procedure or entering the debugging environment to determine the cause 
of the error.

In the latter case, when a procedure executes but does not do what you 
expect, the bug is caused by an error in logic or design. This is the most 
difficult kind of error to detect. When you encounter this type of error, 
you can enter the debugger by inserting a command in the procedure.
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ENTERING THE DEBUGGER FROM A PROCEDURE

In this section, you will create a global procedure to print a list of 
employees who make less than $15,000 a year. You will then use the 
4th Dimension debugger to find the error in this procedure and correct it.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE16 database.

PEOPLE16 starts in the Design environment.

2. Choose Procedure... from the Design menu.

The Procedure dialog box appears.

3. Select Global Procedures and click the New button.

The Procedure Type dialog box appears.

4. Select Listing as the procedure type and type “Employee List” as the 
procedure name.

You can now begin typing the code in your procedure.

5. Enter the following procedure:

`Global procedure Employee List prints a list of employees earning less than
`$15000 a year

OUTPUT LAYOUT([Employees]; “Emp Salary Rep”)
SEARCH ([Employees];[Employees]Salary<15000)
SORT SELECTION([Employees];[Employees]Last Name)
PRINT SELECTION ([Employees])
OUTPUT LAYOUT ([Employees]; “Employee List”)

6. Choose User from the Use menu.

You are now going to execute your procedure in the User environment.

7. Choose Execute Procedure... from the Special menu.

The Execute Procedure dialog box appears.

8. Select the Employee List procedure and click the Execute button.

Nothing happens. You expected a report to be printed, but instead 
4th Dimension displays a message indicating that are no selected records 
for the [Employees] file.

Since the Syntax Error window did not appear, you know that the error is 
in the design of the procedure. In other words, there was a difference 
between what you thought the procedure would do and what 
4th Dimension interpreted and actually did. To determine what is really 
happening as the procedure executes, you decide to examine the 
procedure using the 4th Dimension debugger. 

The easiest way to enter the debugger is by using the TRACE command.
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9. Before returning to the Design environment, choose Show All from 
the Select menu to restore the current selection to all records in the file.

10. Return to the Design environment and open the Employee List 
procedure.

11. Insert the TRACE command at the beginning of the procedure, 
directly after the initial comment.

The TRACE command allows you to trace the execution of a procedure by 
opening the procedure in the Debug window. 

12. Choose User from the Use menu.

4th Dimension returns to the User environment. 

You will now execute the procedure again so that the TRACE command 
activates the debugger.

13. Choose Execute Procedure.. from the Special menu.

14. Select Employee List and click the Execute button.

The Debug window appears, displaying the procedure in which the 
TRACE command was inserted. In the next section, you will use the Debug 
window to locate the error in your procedure.

NOTE: You can also enter the Debug window by Alt-clicking while code is executing. 
Execution is interrupted at this point and the User Interrupt window appears. Clicking the 
Trace button in this window opens the Debug window.
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USING THE DEBUG WINDOW

The Debug window consists of three main areas: the Procedure area, the 
Expression Evaluation area, and the buttons. 

The Procedure area contains the contents of the procedure, including any 
comments that you have inserted. You use this area to view your 
procedure and to see which line is going to be executed next.

The Expression Evaluation area is a special area which returns the result 
of any 4th Dimension function you enter. It can also return the results of 
mathematical expressions (e.g., 4 + 7) and the value of the current field 
(e.g., [Employees] Last Name). This feature of the debugger is extremely 
useful for determining exactly what 4th Dimension is thinking or doing at 
any point in any executing procedure.

The bottom of the Debug window contains the following buttons:

■ Abort: Halts procedure execution and returns you to where you were 
before procedure execution started.

■ No Trace: Stops tracing (i.e., closes the Debug window) and allows 
procedure execution to proceed normally.

■ Step: Executes the current procedure line and stops at the next line.

■ Edit: Opens the procedure in the Design environment for editing.

In this section, you are going to learn how to type expressions in the 
Expression Evaluation area. You will then step through the procedure, 
one line at a time, to see how the results of the expressions change.

1. Enlarge the Debug window to full size by dragging it.

This will allow you to see the entire procedure and will give you more 
room to work in the Expression Evaluation area. 

Procedure area

Expression 
Evaluation area
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2. Enlarge the Expression Evaluation area by holding down the Alt key 
and dragging the Resize line upward.

3. Click in the Expression Evaluation area.

The cursor should now be blinking in the Expression Evaluation area. 

The Expression Evaluation area is initially empty, waiting for you to type 
in a function or other expression. When you click off of the expression, 
the result of the expression is returned for the current line of code. 

You are now going to enter an expression in this area. 

4. Type “Records in File ([Employees])” and click anywhere off of the 
line to evaluate the expression.

Be sure to click off of the line to evaluate the expression—pressing the 
Enter key on the keyboard will evaluate the expression but will also cause 
a line of code to be executed.

When you click off of the line, the Records in file function returns the 
number of records in the [Employees] file to the right of the expression.

The value returned by the expression, 50, tells you that there are records 
in the [Employees] file. However, the command used to print the list of 
employees is the PRINT SELECTION command. When you read the 
description of the command in the 4th Dimension Language Reference, you 
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find that PRINT SELECTION prints the records in the current selection of 
the file—not all of the records in the file. 

NOTE: If you incorrectly type an expression in the Expression Evaluation area, the Syntax 
Error window appears when you click off of the line. If this happens, you must click the 
Abort button to return to the Expression Evaluation area. When you do so, your 
expression is removed from the Expression Evaluation area, allowing you to retype the 
expression correctly.

To determine why the list of employees did not print, we need to 
determine whether there are any records in the current selection. 

5. Move to the next line by clicking under “Records in file.”

The cursor should now be blinking.

6. Click the mouse button and hold down the Ctrl key to display a drop-
down menu of 4th Dimension commands and functions.

7. Select “Selection”, and then “Records in selection” from the 
cascading menu. Release the mouse button.

The Records in selection function appears on the line. You now need to 
enter the name of the file for which you want to return the number of 
records in the current selection.

8. Type “([Employees])”.

The line should now be as follows:

Records in selection ([Employees])
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9. Click off of the line.

The expression is evaluated, indicating that there are 50 records in the 
current selection for the [Employees] file (each file in a database has its 
own current selection).

Since there are 50 records in the file, this means that all of the records in 
the file are in the current selection. If the PRINT SELECTION command 
were executed at this point, all of the records in the file would be included 
in the printout

However, Records in selection is being evaluated at the beginning of the 
procedure, before any lines of code have been executed. The current 
selection may be changed by some of the commands in the procedure. To 
determine the value of the current selection at each point in the 
procedure, you step through the code.

Stepping Through Code
You can use the Step button to step through a procedure, one line at a 
time. When you step through a line of code, 4th Dimension executes only 
that line and then stops at the next line to give you time to evaluate what 
has happened.

An arrow shows which line of code will be executed next. The arrow is 
now located to the left of the first line of the procedure, showing that the 
first line has not yet been executed.

1. Click the Step button to execute the first line of code.

The first line of code is executed. A value of 50 is returned for 
Records in selection, indicating that all of the records in the file are in the 
current selection.
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2. Click the Step button again.

The value of Records in file remains the same, but the value of 
Records in selection changes to 0 after the search criteria 
([Employees]Salary<15000) is evaluated. 

The value of Records in Selection is 0 because there are no employees in the 
company earning less than $15000 a year. Since the current selection is 
empty at this point, there are no records to be printed by the 
PRINT SELECTION command.

Although this is just an example, you would usually want to guard against 
such confusing errors by checking whether there are any records in the 
current selection and, if not, displaying an alert message that states the 
problem.

3. Click the Edit button to edit the procedure in the Design environment.

4. After the SEARCH statement, insert the following If statement:

If (Records in selection ([Employees]) # 0)

This line is equivalent to the sentence, “If the number of records in the 
current selection is not zero, then execute the following lines.”

5. Append the following statements after the last line of the procedure:

Else
ALERT (“There are no records to print.”)

End If

These lines are equivalent to the sentence, “Otherwise, present an alert 
stating that there are no records to print.”

6. Insert the comment character ( ` ) before the TRACE command.

This disables the TRACE command by making it a comment. Comments 
are not executed by 4th Dimension.
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The finished procedure should look like this:

7. Return to the User environment and choose Execute Procedure... 
from the Special menu.

8. Select Employee List and click the Execute button.

The Debugger reappears because when you previously clicked the Edit 
button in the Debugger you were in TRACE mode. Now that you have 
returned to the User environment to execute the procedure, you are still 
in TRACE mode.

9. Click the No Trace button.

This allows you to continue executing your procedure without the 
interruption of the debugger.

An Alert box appears, as shown below.

10. Click OK to close the Alert box.
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USING THE SYNTAX ERROR WINDOW

In this section, you are going to write a global procedure that creates a 
unique code for each employee in the company. The code will be created 
by combining the employee’s last name and start date.

Code such as this is frequently used for tracking employees. For instance, 
you could use the code to identify which employee entered a given 
invoice or purchase order. You could use this same code to link related 
employee files, such as employees and their expenditures.

Your first task is to create the field that will store the employee code and 
then place the field on a layout.

1. Return to the Design environment by choosing Design from the Use 
menu.

2. Create a new field named “EmpCode” and make it Alpha 25.

This field will store the code for each employee.

3. Choose Layout... from the Design menu and click the New button to 
create a new layout.

Since Employee Code is a new field, you need to create an output layout 
that includes the field.

4. Choose layout template #1 and name the layout “Code”.

5. Make the font size 9-point.

6. Select the First Name, Last Name, Start Day, and EmpCode fields and 
click OK.

The output layout appears, containing these four fields.
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7. Double-click the Control-menu box to close the layout.

Now that you have a layout that includes the EmpCode field, you need to 
enter a code into each employee’s record. Since the code is created from 
information already in your database, the way to update the field is to 
apply a global procedure as a formula to all employee records.

In the next step, you are going to create the global procedure that will 
generate an employee code for each record. Remember that when 
entering the procedure, you can use the panels in the lower portion of the 
screen to enter the field names and the “:=” and “+” operators. For more 
information about using the Procedure editor, refer to Chapter 6.

1. Create a new global procedure named “CreateCode” and enter the 
following statements:

`CreateCode creates a code by adding employees’ last name and start day
[Employees]EmpCode:=[Employees]Last Name + [Employees]Start Day

Translated literally, the last statement means that “the EmpCode field gets 
the value of the employee’s last name plus the employee’s start date.” For 
instance, the code for Rick Jones, whose start date is 10/30/89, would be 
Jones103089.

2. Go to the User environment by choosing User from the Use menu.

You now want to apply the CreateCode procedure as formula to all records 
in the database so that a code is created for each employee.

3. Press Ctrl+Space bar to bring up the List of Files window.

You are going to use this window to make Code the default output layout.

4. Hold down the mouse button on the Output layout icon for the 
[Employees] file and choose the Code layout from the drop-down menu.

If you repeat this step, you will see that Code is now underlined, 
indicating that it is now the default output layout.

5. Press Ctrl+Space bar again to hide the List of Files window.

6. Choose Show All from the Select menu.

This ensures that all of the records in the [Employees] file are currently 
selected. This is important since formulas are applied to the current 
selection of a file—not necessarily to the entire file. 

7. Choose Apply Formula... from the Enter menu.

The Formula editor appears, allowing you to build a formula which you 
can then apply to the current selection of the file. 

You can also apply a global procedure as a formula. You are going to select 
the CreateCode procedure which contains the formula for creating the 
employee codes.
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8. Scroll to the end of the Routines list and click CreateCode, the name 
of the global procedure you want to apply.

The names of all global procedures appear at the end of the Routines list 
in italics.

9. Click OK to apply the formula to the employee records.

The Syntax Error window appears with the message “This operation is not 
compatible with the two arguments,” as shown below. Notice that 
4th Dimension highlights the part of the command which contains the 
error, in this case, the [Employees]Start Day field. 

The buttons at the bottom of the Syntax Error window give you the 
following four options:

■ Abort: Halt procedure execution and return to where you were before 
procedure execution started.

■ Trace: Use the Debug window to trace (i.e., step through) the 
procedure’s execution.

■ Continue: Continue executing, skipping any portion that cannot be 
executed.
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■ Edit: Open the procedure in the Design environment so it can be 
corrected.

10. Click the Trace button to enter the Debug window.

The Debug window appears, displaying the contents of the CreateCode 
procedure. 

DEBUGGING A SYNTAX ERROR

You know that the bug in the procedure is due to a syntax error 
concerning the [Employees] Start Day field. The field is somehow 
incompatible with the operation you were trying to perform—the 
addition of the two fields. 

In the 4th Dimension Quick Start manual, you learned that fields can have 
different data types. For instance, a field that stores a name is usually an 
Alpha field, meaning that it stores alphanumeric data (A-Z; 0-9). A field 
that stores a salary is usually a Real field, meaning that it stores numbers 
with decimal points.

Since operations sometimes require fields of particular data types, you 
decide to determine the data types of what the Syntax Error window calls 
the arguments of the statement, the [Employees] Start Day and 
[Employees] Last Name fields.

1. Click in the Expression Evaluation area.

The cursor should now be blinking.

2. Enter “Type (”.

The Type function returns the data type of the specified field. For more 
information about the Type function, refer to the 4th Dimension Language 
Reference.
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3. Alt+click to display a drop-down menu of file and field names.

Alt+clicking in the Expression Evaluation area is a shortcut for entering 
file and field names.

4. Choose “[Employees] Start Day” from the drop-down menu and type 
a closing “)”.

The final statement should look like this:

Type ([Employees]Start Day)

NOTE: Remember that if you enter the Type function incorrectly, the Syntax Error window 
will appear indicating the error. When you click the Abort button in this window to 
return to the Expression Evaluation area, the function will be removed and will need to 
be retyped.

5. Click off of the line to evaluate the expression.

The first function returns the value 4, which means that the Start Day 
field is of type Date. A table containing a list of data types that can be 
returned by the Type function can be found in the 4th Dimension Language 
Reference.

6. Enter the following function in the Expression Evaluation area.

Type ([Employees]Last Name)

You can either type the entire statement or use some of the shortcuts 
discussed in this chapter, such as Ctrl+clicking to choose the Type 
function and Alt+clicking to choose “[Employees] Last Name”.
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7. Click off of the line.

The second function returns the value 0, which means that the Last Name 
field is of type Alpha.

The two fields, Start Day and Last Name, have different data types. Since 
“+” can only be used to add fields of the same data type, it cannot be used 
to add a date and an alphanumeric string. To add these two fields, you 
must first convert the Start Day field into a string.

8. Click the Abort button.

The CreateCode procedure is aborted.

9. Return to the Design environment and choose Procedure from the 
Design menu.

10. Select the “CreateCode” procedure and click the Open button to 
open the procedure in the Procedure editor.

11. Insert the String function after the “+” and place parentheses around 
[Employees]Start Day.

The final procedure should look like this:

[Employees]EmpCode:=[Employees]Last Name+String([Employees]Start Day)

The String function that you inserted converts the Start Day field from a 
date to a string. Note that this has no effect on the data stored in the Start 
Day field—it simply converts the data into a string temporarily so that it 
can be used in this operation.

For more information about the String function and how it converts data, 
refer to the 4th Dimension Language Reference.

You can now return to the User environment to execute your procedure 
again.



USING THE DEBUGGER

USING THE DEBUGGER 16

16-17

12. Choose User from the Use menu.

13. Choose Apply Formula from the Enter menu, select the CreateCode 
procedure, and click OK.

This time the procedure works properly. The output layout for the 
[Employees] file is displayed with the new values in the EmpCode field.

THE NEXT STEP

The 4th Dimension debugger is a valuable tool for locating and correcting 
bugs in any procedure. In this chapter, you created two example 
procedures for the purpose of learning how to find the two types of bugs 
that you may encounter in your procedures: syntax errors and errors in 
logic or design. In each case, you entered the debugger and used the 
Expression Evaluation area to enter functions that helped you detect the 
errors.

Now that you have finished adding features to your database, you will 
want to protect your employee data by implementing a password access 
system. In the next chapter, you will learn how to create different levels 
of access that can be used to restrict users to certain parts of the database.
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Database: PEOPLE17
Estimated time to complete: 15 minutes

When you create a database that will be used by more than one person, 
you may need to set up a password access system to limit access to data. 
An access system requires each person who uses an application to enter a 
password and, based on what privileges the person has been given, 
controls what portions of the database the person can use.

For example, you may hire a temporary employee to enter some 
information into your database. You can easily provide that person access 
to enter or modify records, but you may want to reserve other parts of the 
database for authorized employees only.

In this chapter you will learn how to:

■ Use 4th Dimension’s Password Access editor,

■ Set up an access system for users of your personnel application,

■ Specify which users can enter the Design environment,

■ Specify which users have access to each menu command,

■ Specify how users enter their name—whether they choose their name 
from a list or whether they must type their name.
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USERS AND GROUPS

The password access system provided by 4th Dimension is based on the 
concept of users and groups. Users are assigned to groups and groups are 
given access rights to different parts of a database.

You can create user names and passwords for as many users as you want. 
When you create a database, 4th Dimension defines two users who are 
given special access privileges:

■ Designer: This user has access to everything in all environments—
Design, User, and Runtime. The Designer can create and delete groups, 
assign and change group access privileges, and reassign users to different 
groups.

■ Administrator: This user is responsible for overseeing the application 
on a daily basis. The administrator can add and delete users and assign 
them to groups.

Groups can contain any number of users and can even contain other 
groups. Once you have placed users in groups, you can restrict access to 
the database by giving groups access to different parts of the database. 

One common way to limit access to a database is to restrict record 
operations to different groups, based on their need. Records in each file 
can be loaded, saved, added, or deleted, depending on which group is 
given access to each function.

As you can see from the File Attributes dialog box in the figure above, all 
groups have the right to load, save, or add records, but only users 
belonging to the Executive group can delete records. 

You can restrict access to other parts of your database, depending on your 
needs. For instance, you might want to restrict access to different layouts 
in your database so that you can control which data users can enter and 
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view. The elements of the database for which you can restrict access 
include the following:

■ Design environment,

■ Record operations (loading, saving, adding, and deleting),

■ Layouts,

■ Procedures,

■ Menu commands,

■ External packages, such as the 4th Dimension modules.

In this chapter, you are going to add users and groups to the password 
access system. You are then going to restrict users to different portions of 
the database by assigning access to each of the menu commands in your 
runtime application and to the Design environment.

Adding Users and Groups
You know that there are several likely users for your application—
 yourself, members of the MIS department, the head of the Human 
Resources department, her secretary, and possible temporary workers. 

You need to enter these people as users and assign each of them a 
password. You then need to assign the users to the appropriate groups.

1. If you have not done so already, start 4th Dimension and open the 
PEOPLE17 database.

PEOPLE17 starts in the Design environment.

2. Choose Passwords... from the Design menu.

4th Dimension displays the Password Access editor.

The Password Access editor shows two sets of boxes. The Users box 
displays the list of users. Currently, it contains the Designer and 
Administrator. Later, it will also display the users you add. The groups a 

User list

Groups list
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selected user belongs to are displayed in the box below the Users box. 

The Groups box displays the list of groups you create. The names of users 
belonging to a selected group are displayed in the box below the Groups 
box.

3. Choose New User... from the Passwords menu. 

4th Dimension displays the Edit User dialog box. You enter information in 
this dialog box for each user you add to the system.

The Edit User dialog box allows you to enter and edit user names and 
passwords. You can also use this dialog box to assign a startup procedure 
that executes when the user opens the database and to allow members of 
a specified group to modify any objects (layouts, procedures, and so on) 
that the user creates. In addition, you can view the last date and the 
number of times the user has entered the database. 

For more information about these features, refer to the 4th Dimension 
Design Reference.

4. Enter “Alice” as the user name and “RestauranT” as the password.

For extra security, you capitalize two letters in the password. 
4th Dimension’s access system is case-sensitive so Alice (the head of the 
Human Resources department) will have to capitalize both the first and 
last letters of the word “restaurant” when she enters her password.

Do not change the other boxes. Leaving the Startup Procedure box blank 
allows Alice to use the User environment as well as the Runtime 
environment.

5. Click OK.

4th Dimension closes the Edit User dialog box and adds Alice to the list of 
users.
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6. Add the following users and passwords to the password access 
system.

Notice that the password for Helen, the Human Resources department 
secretary, includes a number. This is another way to ensure password 
security.

The password for the temporary worker is simple, easy to remember, and 
appropriate. If necessary, you can change it.

You do not need a user name for yourself since you plan to use the 
Designer name.

You are now going to create the groups you want to use.

7. Choose New Group... from the Passwords menu.

4th Dimension displays the Edit Group dialog box.

4th Dimension allows you to name the group and to choose a group owner 
from among the users already created. The group owner can add and 
delete users from the group. Normally, you leave the Administrator (the 

User Name Password
Helen Gos6h

Branford sixER

Temporary Temp
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default) as the group owner.

8. Enter “General” as the group name and ignore the Group Owner box.

This is the group that will contain all users.

9. Click OK.

General is added to the list of groups.

10. Create two more groups with the names “Managers” and “MIS”. 

Your completed list of users and groups should look like this:

You are now ready to assign users to various groups.

Placing Users into Groups
You place users into groups by dragging their names from the Users list to 
a group in the Groups list. Once a name is in a group, it appears in the 
group members list.

You are going to place Alice, Helen, and Temporary in the General group, 
Alice in the Managers group, and Branford in the MIS group. You do not 
need to place Designer in a group, since the Designer has access to 
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everything.

1. Select Alice from the Users list and drag her name to the General 
group.

When you release the mouse button, Alice appears in the list of group 
members.

2. Place Helen and Temporary in the General group.

These names are added to the group members list.

3. Place Alice in the Managers group and place Branford in the MIS 
group.

If you accidentally add a user to the wrong group, simply select the user 
name in the Group list and drag it back to the same name in the Users list. 

ASSIGNING GROUPS ACCESS

You have now created the user names you need and assigned the users to 
groups. Now you need to assign the groups to different portions of the 
application. This step will complete the installation of your access system.

You have named the groups so that you know who is in each group. You 
need to assign the Managers group to those portions of your application 
that you want only the head of the Human Resources department to be 
able to use. You also want to ensure that only you (the Designer) and 
members of the MIS group can enter the database in the Design 
environment to make modifications. 

1. Open the Menu editor to show Menu Bar #1 which contains the menus 
for your application.

These are the menus you created in Chapter 14.

Group members list
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2. Select the Reports menu and then select the Monthly menu 
command.

Selecting a menu command activates the Access drop-down list box. 
Currently, the drop-down list box displays “All Groups.” This means that 
users in any group can access the menu command in the Runtime 
environment. You want to change this so that only Alice, the Human 
Resources manager, can generate a monthly report of the employees and 
salaries in the company.

3. Choose Managers from the Access drop-down list box.

The Managers group now has access to the Monthly menu command. 
Only Alice will be able to use this menu command.

4. Assign Managers to the Quarterly and Graph menu commands.

Remember to select the menu command and then choose Managers from 
the Access drop-down list box each time.

5. In a similar way, assign the following groups and menu commands:

When your application is used in the future, only those users belonging 
to these groups will be able to use the assigned functions.

6. Close Menu Bar #1.

Now that you have specified which menu commands can be used in the 
Runtime environment, you want to specify which group can enter the 

Menu Menu Command Group
Department Add Department Managers

Modify Department General

Remove Department Managers

Employees Add Employee General

Modify Employee General

Remove Employee Managers
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database in the Design environment. As the Designer, you will always be 
able to enter the Design environment. However, you would also like to 
give access privileges to Branford, a member of the MIS group.

7. Choose Preferences... from the File menu.

The Preferences dialog box appears.

8. Choose MIS from the Structure Access drop-down list box.

The MIS group is now assigned access privileges to the Design 
environment.

9. Click OK to close the Preferences dialog box and save your 
preferences.
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SEEING THE SYSTEM IN ACTION

There is actually one more preliminary step to establish the access system 
for your application. This step is the key to the whole system:

You must give the Designer a password to initiate the access system.

Only when the Designer has a password does the system take effect—not 
before. To disable the access system, simply remove the password from 
the Designer.

1. Click on the Password Access editor to activate it and select 
Designer from the Users list.

2. Choose Edit User... from the Passwords menu.

The Edit User dialog box is displayed.

3. Give the Designer the password “BilbOw”. 
OR
Make up one of your own.

If you make up your own password, be sure it is a password you can 
remember. Otherwise, you will not be able to reenter this database. 

4. Click OK.

Giving the Designer a password activates the access system. You can now 
proceed to test the system.

5. Choose Quit from the File menu.

You must quit from 4th Dimension because the access system takes effect 
on startup.
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6. Run 4th Dimension and open the PEOPLE17 database again.

This time, after the initial screen, 4th Dimension displays the Enter 
Password dialog box. The list contains all the user names you have 
created, plus the Designer and the Administrator.

You are going to enter the database as the Designer. Since Designer is 
already selected, you need only enter the Designer’s password.

7. Type “BilbOw” as the password.

Remember that the password is case-sensitive. You must use a capital B 
and O.

As you type the password, 4th Dimension displays icons instead of 
characters. The icons are displayed instead of the characters so that no 
one can read your password when you type it.

8. Click OK.

4th Dimension opens in the Design environment. You can use your 
application by changing to the Runtime environment. Entering as the 
Administrator, by the way, starts in the User environment.

Notice that when the Enter Password dialog box appeared, you were able 
to select your name from a list of users. For security reasons, you would 
like to change this so that users must type both their name and their 
password. 

9. Choose Preferences... from the File menu.

The Preferences dialog box appears.

10. Select the Enter User Name in Password Dialog check box.

This changes the password access system so that users are required to 
enter their name instead of simply selecting it from a list.
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11. Click OK to close the Preferences dialog box and save your 
preferences.

12. Choose Quit from the File menu.

13. Run 4th Dimension again, this time typing “Helen” as the user name 
and “Gos6h” as the password. 

14. Click OK in the Enter Password dialog box.

The database opens in the User environment. You could create a Startup 
procedure to make the database open directly in the Runtime 
environment.

15. Pull down the Use menu.

Notice that the Design menu command is dimmed, indicating that Helen 
cannot enter the Design environment.

16. Switch to the Runtime environment and choose several menu 
commands.

The menu commands that have been assigned to the General group can 
be used at this time since Helen belongs to this group. The menu 
commands that have been assigned to the Manager group cannot be used.

Feel free to play around with the access system, creating new user names 
and passwords, adding groups, assigning them to different parts of the 
system. You can even write startup procedures [such as ALERT(“Hello there 
Phil! Welcome to my personnel application!”)] to be displayed at the beginning 
of a user’s session.
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THE NEXT STEP

The 4th Dimension access system is flexible, yet simple. Using this system, 
you can provide complete security for your application and for your 
information. Once you have created a few user names and groups, 
protecting different parts of your program is easy. 

You maintain the access system by adding new users to the proper groups, 
deleting users who no longer need to be in a particular group, and by 
creating new groups for special purposes.

Even if you do not create a runtime application, you can protect your data 
by assigning the Designer a password. No one can open the database 
without knowing the password. 

For more information about creating a password access system, refer to 
the 4th Dimension Design Reference.

Congratulations! You have finished the tutorials in this manual and are 
now ready to apply your knowledge to your own databases. Have fun with 
4th Dimension!
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Symbols
! (exclamation point)

in entry filter codes 5-3
# (number sign)

as a placeholder 5-3
& (ampersand character)

in entry filter codes 5-3
(()) (parentheses)

in procedures 7-7
+ (plus symbol), as a string oper-

ator 16-16
:= (assignment operator)

in procedures 7-6
in scripts 6-3, 6-6

> (greater than character)
in sorts 15-11

@ (wildcard character)
in searches 11-8

` (accent mark), for comments in 
procedures 7-6, 15-4

~ (tilde character)
forcing capitalization 5-3

Numerics
4th Dimension

control panel in 2-1
default data entry order 3-6
language 15-2

A
Abbreviated date format 1-18
accent marks

for comments in procedures 
7-6, 15-4

Accept action, for buttons 2-5
Access drop-down list box 17-8
access privileges

Administrator 17-2
assigning to groups 17-7 to 

17-9
Designer 17-2
using 17-10 to 17-12

Action drop-down list box
Accept action 2-5
Cancel action 2-7
Next Record action 2-7
Previous Record action 2-7

Active Object tool/icon 2-2, 3-5
adding active objects 13-8

active objects 2-2 to 2-5
adding 2-1, 13-8
buttons 2-1 to 2-10
non-enterable 13-13

Add Field tool/icon 4-6, 6-4, 
13-7

ADD RECORD command 15-2, 
15-7

Add to Layout menu command 
3-4

Administrator 17-2
as group owner 17-5

alert box, in data validation 5-10
Align Center Vertical tool/icon 

1-15
Align Right tool/icon 1-14
Align Top tool/icon 2-7, 4-7
alignment tools 1-14 to 1-15
ampersand (&) character

in entry filter codes 5-3
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And conjunction 11-4 to 11-5
arguments

in statements 16-14
Arrow tool/icon 1-8
assignment operator (:=)

in procedures 7-6
in scripts 6-3, 6-6

Automatic Relate One to Many 
option, with related files 
9-5

B
borders

creating 4-7, 10-5
resizing 1-19

Break areas
defined 13-3
example of 13-2

Break control lines
creating 13-5
in reports 13-5

Break Header areas
in Layout editor 13-2, 13-3

break levels
in quick reports 12-3

Break rows 12-3
creating 12-6

breaks
in quick reports 12-3

bugs, debugging code 16-1 to 
16-17

buttons
Accept 2-5
aligning 2-7
as active objects 2-3 to 2-5
creating 2-2 to 2-5
duplicating and editing 2-6 

to 2-7
naming 2-4, 3-5
Next Record 2-7
Previous Record 2-7
using custom 2-8 to 2-10

C
calculations

in quick reports 12-3
Subtotal function 13-10 to 

13-12
sums in quick reports 12-6
totals in reports 13-12

Cancel action, for buttons 2-7
Cancel button 4-8

cancelling a record 5-10, 6-9
capitalization

functions for 7-5 to 7-7
tilde (~) character for 5-3

case sensitivity, in passwords 
17-4

choice lists. See lists
Choices check box 4-4, 5-7
Clear menu command

clearing search conditions 
11-4

Search editor 11-7
Clipboard

storing copied objects 14-10
code

debugging 16-1 to 16-17
Collapse button

for listing procedures 7-3
Command-n

creating object borders 4-7, 
10-5

commands
ADD RECORD 15-7
automatic indentation of 

15-7
explanation of 6-3
MODIFY SELECTION 15-9
PRINT SELECTION 15-11, 

16-6
SEARCH 15-9
SORT SELECTION 15-11
TRACE 16-3 to 16-4

conjunction operators
And 11-4 to 11-5
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Or 11-5 to 11-6
control lines 13-3
Control-menu box 6-7
control panel 2-1
Copy menu command

copying buttons 3-5
creating

buttons 2-2 to 2-5
files 8-3 to 8-4
included layouts 9-2 to 9-3
input layouts 1-2 to 1-4
lists 4-2 to 4-3
menus 14-3 to 14-9
output layouts 1-5 to 1-7
quick reports 12-4 to 12-8
subfiles 10-3 to 10-7

Criteria area
in Search editor 11-3

Ctrl+Space bar
changing between layouts 

6-9
displaying List of Files 

window 2-8 to 2-9, 
5-9, 8-9, 9-4

current selection
printing quick reports 12-3

Custom layout template 1-3
cycle arrows 6-3

D
data

display formats for 1-16 to 
1-20

entering in subfiles 10-7 to
 10-9
importing 8-9 to 8-11

data entry order 3-6 to 3-10
changing 3-7 to 3-10
default 3-6

Date field formats
Abbreviated 1-18
Long 1-18
Short 1-18

Data Import  dialog box 8-10
data validation 5-2 to 5-11

setting for fields 4-6
using 5-9 to 5-10

Debug window 16-4 to 16-10
buttons in 16-5
Expression Evaluation area 

16-5 to 16-7
Procedure area 16-5

debugging code 16-1 to 16-17
Default box 6-8
default data entry order 3-6
default field type, Alpha 4-4
default values

explanation of 6-1
using 6-8

Design environment
creating custom buttons in 

2-8
creating subfiles in 10-3

Design menu 7-3
Layout menu command 1-2, 

1-5, 1-7, 3-7
Lists menu command 4-2
Menu menu command 14-4
Procedure menu command 

7-3
Structure menu command 

4-4
Designer

access to environments 17-9
assigning a password to 

17-10 to 17-12
Detail area 13-2, 13-3
Detail cell, in quick reports 12-7
Detail control line 13-6
Detail row 12-3
display formats

for dates 1-18
for numbers 1-19
setting 1-16 to 1-20
using 5-3 to 5-5

Display Only attribute 6-4
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Double-clickable check box 10-7
Double-clicking

changing field attributes 5-2
displaying layouts for files 

4-5
displaying the Field 

Definition dialog box 
1-19

opening the Layout dialog 
box 2-2

selecting fields 1-6
Duplicate tool/icon 2-6

E
Edit Group dialog box 17-5
Edit menu

Clear menu command 11-4
Copy menu command 3-5
Insert Break menu 12-6
Paste menu command 3-5
Select All menu command 

13-5
Undo menu command 1-8, 

1-10, 2-7
Edit User dialog box 17-4, 17-10
Enter button 4-8

returning to output layout 
10-9

Enter menu
entering data in subfiles 10-8
Modify Record menu 

command 1-22, 2-8, 
4-8, 9-4

New Record menu command 
5-9, 6-9, 8-12

Enter Password dialog box 17-11
Enterable attribute

for fields 5-7
Entry Filter drop-down list box 

5-4
entry filters

creating 5-3 to 5-5
symbols in 5-3

using 5-3 to 5-5
Entry Order menu command 3-8
environments

changing between 15-6
errors

debugging 16-14 to 16-17
flagging in procedures 15-5
in code 16-1
in design 16-2, 16-17
in logic 16-2, 16-17
in procedures 16-3 to 16-17
syntax 16-2

exclamation point (!)
in entry filter codes 5-3

Execute button 16-4
Expand button 10-7

for listing procedures 7-3
showing file layouts 1-7

F
field attributes

as data validation 5-2 to 5-3
Field Attributes dialog box 10-3

adding fields 4-4
data validation in 5-2

Field Definition dialog box 6-5
setting display formats 1-17, 

4-6
setting entry filters 5-3 to 5-4
validating entries 5-6

field labels 1-17
field names

in search conditions 11-2
fields

adding 4-4 to 4-5
adding to layouts 3-4
choosing for layouts 1-3
default type of 4-4
display formats for 1-16 to 

1-20
placing on layouts 1-5 to 

1-7, 4-5 to 4-7
resizing 1-19
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searching indexed 11-2
searching on in related files 

11-7 to 11-8
selecting in Procedure editor 

6-3
File Attributes dialog box 17-2
file icon 8-3
File menu

Import Data menu 
command 8-9

Preferences menu command 
17-9, 17-11

Print menu command 12-8
Quit menu command 14-4 

to 14-5, 17-10
Revert to Saved menu 

command 1-10, 1-13
Save Layout menu command 

1-11
Undo menu command 1-15

file procedures 7-2
files

creating 8-3 to 8-4
related 8-1 to 8-2
relating 8-5 to 8-6

Files list 6-3, 7-5
Fill menu command 1-12
Fill Pattern cascading menu 1-12
Flowchart editor 7-4
Footer area 13-3, 13-4
Footer control line 13-5
Format Display area 5-5, 6-5

formatting numbers 1-20
Format menu command 1-17
Format drop-down list box 1-18, 

5-5, 6-5
Formula editor 16-12
Full Page check box 10-7
functions

explanation of 6-3
input values 7-5
output values 7-5

G
global procedures 7-2 to 7-4

creating 15-3 to 15-5
debugging 16-3 to 16-17

greater than (>) character
in sorts 15-11

groups
adding to password access 

system 17-3 to 17-6
assigning access privileges to 

17-7 to 17-9
assigning users to 17-6 to 

17-7
in password access system 

17-2 to 17-3
limiting access of 17-2
owner of 17-5

Groups box 17-4
Groups list 17-4, 17-6

H
handles

around selected objects 1-9
for resizing objects 1-8 to 

1-10
Header area 13-2, 13-3
Header control lines 13-6
Header row 12-3

I
I-beam pointer 1-10
Import Data menu command 8-9
importing data 8-9 to 8-11
Included Layout dialog box 10-6
included layouts

creating 9-2 to 9-3
indexed fields

searching 11-2
Input check box 10-7
Input Layout icon 2-8
input layouts

changing between 6-9
creating 1-2 to 1-4
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displaying 1-7
scrollable lists in 9-4

Items menu
New menu command 4-2
Sort menu command 4-3

Items panel 4-2

K
Keyboard check box 14-8
keyboard equivalents

adding for menu commands 
14-8

Keywords list 6-3, 6-6, 7-5

L
Layout dialog box

creating input layouts 1-2
creating output layouts 1-5
List of Files 1-2
opening layouts from 1-7

Layout editor
alignment tools 1-14 to 1-15
changing data entry order 

3-6 to 3-10
creating custom reports in 

13-1
creating layouts in 1-7
description of 1-1, 1-8
displaying layouts in 1-3
drawing tools in 1-11 to 1-13
modifying layouts in 1-7 to 

1-11
placing fields on layouts 4-5
scroll bars in 3-2
setting display formats in 

1-16 to 1-20
Layout editor window

changing data entry order in 
3-7

Layout menu
Add to Layout menu 

command 3-4
Entry Order menu command 

3-8
Ruler Units menu command 

13-4
Layout menu command 1-2, 

1-5, 1-7, 3-7
layout name 1-11
layout palette

Active Object tool/icon 2-2
Add Field tool/icon 4-6, 6-4
Align Center Vertical 

tool/icon 1-15
Align Right tool/icon 1-14
Align Top tool/icon 2-7, 4-7
alignment tools/icons 1-14 

to 1-15
Duplicate tool/icon 2-6
Move to Back tool/icon 1-13
Move to Front tool/icon 

1-13, 1-14
Next Page/Previous Page 

tools/icons 3-3
Oval tool/icon 1-13
Pointer tool/icon 3-10
Previous Page tool/icon 3-5
Rectangle tool/icon 1-14
Text Area tool/icon 1-10, 4-6

layout procedures 7-2
layout templates. See templates
layout title 1-11
layouts

adding buttons to 3-5
adding fields to 3-4
adding pages to 3-2 to 3-3
choosing fields for 1-3
creating input 1-2 to 1-4
creating output 1-5 to 1-7
displaying input 1-7
displaying output 1-7
modifying 1-7 to 1-15
moving objects on 1-8
multi-page 3-2
naming 1-3
placing fields in 1-5 to 1-7, 
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4-5 to 4-7
report 13-2 to 13-4
selecting in Procedure editor 

6-3
single-page 3-2
using multi-page 3-6

Line Width menu command 
1-12

cascading menu 1-12
List button 4-4, 5-7
List editor 4-8

creating lists 4-2
List of Files window 2-8, 6-9, 8-9

activating 2-8
displaying 10-7

Listing editor 7-4
Listing radio button 6-6
lists

creating 4-2 to 4-3
displaying in Lists dialog box 

4-4
making required 5-7 to 5-8
using 4-8

Lists dialog box 4-4
Lists menu

New menu command 4-2
User Modifiable menu 

command 4-3
Lists menu command 4-2
Lists panel 4-2
Load button 11-6
Long date format 1-18

M
Mandatory attribute 5-2

explanation of 5-2
for fields 5-7

Many file 8-2
relating files with 8-5

Many to Many relations 9-5
Many to One relations 8-2
marquees

for setting data entry order 

3-9
Maximize button 2-2

expanding layouts 1-4
expanding windows 1-8

maximum and minimum values
setting 5-6

menu bars
adding graphics to screens 

14-10
creating 14-3 to 14-5
explanation of 14-3
previewing 14-10

Menu Bars dialog box 14-4
Menu editor 14-4

Access drop-down list box 
14-9

creating menus 14-4 to 14-9
Enabled check box 14-9
enhancing menus 14-8 to 

14-9
Keyboard check box 14-8
Line check box 14-9
previewing menu bars 14-10
Start a New Process check 

box 14-9
menu commands

creating processes with 
15-12 to 15-14

enhancing 14-8 to 14-9
role of 14-3

Menu menu 14-10
menus

creating 14-3 to 14-9
enhancing 14-8 to 14-9
entering titles 14-5 to 14-8

Menus column 14-5
Modify Record menu command 

1-22, 2-8, 4-8
MODIFY SELECTION command 

15-9
Move to Back tool/icon 1-13
Move to Front tool/icon 1-13, 

1-14
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multi-page layouts 3-2
adding pages to 3-2 to 3-3
using 3-6

multi-tasking 15-12

N
New button

creating input layouts 1-3
creating output layouts 1-5

New Field menu command 4-4
New File menu command 8-3
New Layout dialog box 10-6, 

13-4
adding fields to layouts 3-4
creating output layouts 1-5
explanation of 1-3

New Record menu command 
5-9, 6-9

Next button 2-9
Next Page action 3-5
Next Page button

adding to layouts 3-5
Next Page tool/icon 3-3
Next Record action 2-7
non-enterable objects 13-9, 

13-13
number (#) sign

as a placeholder 5-3

O
Object Action drop-down list 

box
Accept action 2-4
Cancel action 2-7
Next Page action 3-5
Previous Page action 3-5

Object Definition dialog box
adding buttons to layouts 

3-5
creating buttons 2-3
creating scripts 13-8
naming buttons 2-4

Object menu

Format menu command 
1-17

Line Width menu command 
1-12

Object Type drop-down list box
Button menu command 2-4, 

3-5
objects

aligning 2-7
borders for 10-5
copying on layouts 2-6
line widths for 1-12
moving 1-8
resizing 1-8
resizing handles 1-8
selecting multiple 1-14

One file 8-2
accessing records from 9-5

One to Many relations 9-1 to 9-5
Open button

opening layouts 1-8
Operator area 11-3
operators

in search conditions 11-2
Option-clicking

to create Break markers 13-5
to enter the Debug window 

16-4
to open scripts 7-8

Or conjunction 11-5 to 11-6
Output Layout icon 2-8
output layouts

creating 1-5 to 1-7
displaying 1-7
restoring in procedures 

15-11
templates for 1-5

Oval tool/icon 1-13
Owner

setting for groups 17-5

P
parent files 10-1
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parent records 10-1
parentheses (())

in procedures 7-7
Password Access editor

Groups box 17-3
Groups list 17-3
Users box 17-3
Users list 17-3

password access system
adding users and groups 

17-3 to 17-6
Administrator 17-2
Designer 17-2
disabling 17-10
explanation of 17-1
users and groups in 17-2 to 

17-3
using 17-10 to 17-12

passwords
case sensitivity 17-4
icons for 17-11

Passwords menu
Edit User menu command 

17-10
New Group menu command 

17-5
Paste menu command

adding buttons 3-5
pixels

in layout rulers 13-4
plus (+) symbol, as a string 

operator 16-16
Pointer tool/icon 3-10
pointers

Arrow tool/icon 1-8
corner marker 3-4
I-beam 1-10
small arrow 3-8

Preferences dialog box 17-9
Preview on Screen check box 

13-15
printing quick reports 12-8

Previous button 2-10

Previous Page action 3-5
Previous Page button

adding to layouts 3-5
Previous Page tool/icon 3-5
Previous Record action 2-7
PRINT SELECTION command 

15-11, 16-6
Procedure dialog box 7-3

Layout Display area 7-3
Procedure editor 6-2 to 6-3, 15-3 

to 15-5
Flowchart editor 6-2
Keywords list 6-3
Listing editor 6-2
opening 7-3 to 7-4

Procedure menu command 16-3
Procedure Type dialog box 6-5, 

7-4
procedures 7-1 to 7-9

creating global 15-3 to 15-5
creating report 15-10 to 

15-11
debugging 16-3 to 16-17
description of 15-2
errors in 15-5
modifying 15-7 to 15-8
using 15-6 

Procedures column 14-7
processes

creating with menu 
commands 15-12 to 
15-14

description of 15-12
programs 15-2

Q
Quick Report editor 12-4

Break rows 12-3
Detail row 12-3
Header row 12-3
Totals row 12-3
using 12-2 to 12-8

Quick Report layout 12-4 to 12-8
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quick reports
break levels in 12-3
creating 12-4 to 12-8
example of 12-2
report design 12-2
sort levels in 12-3

R
Real fields 6-4
records

entering 1-4, 9-4 to 9-5
importing 8-9 to 8-11
moving between 2-10
viewing 9-4 to 9-5

Rectangle tool/icon 1-14
related files 8-1 to 8-15

creating file relations 8-5 to 
8-6

searching on fields in 11-7 to 
11-8

relations
One to Many 9-1 to 9-5
removing 8-6

report control lines 13-3
using 13-4 to 13-7

Report menu 12-4
reports

creating with Quick Report 
editor 12-2 to 12-9

example of 13-2
layouts for 13-2 to 13-4
printing 13-14 to 13-16
using control lines in 13-4 to 

13-7
Required check box 5-8
Revert to Saved menu command 

1-13
returning to original layouts 

1-10
routines 7-5, 15-2
Routines list 6-3, 7-5
runtime applications 14-1 to 

14-2

Runtime environment 14-1
purpose of 15-1
quitting from 15-6

S
Save button 11-6
Script editor, opening 7-8
Script Only if Modified check 

box
deselecting for reports 13-8

scripts 7-2 to 7-3
description of 6-1
Script Only if Modified check 

box 13-8
using in reports 13-8 to 

13-14
writing 6-4 to 6-7

scroll bars
in included layouts 10-9
in Layout editor 3-2

Search and Modify editor 11-9
Search by Formula editor 11-9
Search by Layout editor 11-9
Search by Layout menu com-

mand 11-1
SEARCH command 15-9
search conditions

And conjunction 11-4 to 
11-5

element order in 11-2
explanation of 11-2
Or conjunction 11-5 to 11-6
using 11-2

Search editor 11-1 to 11-9
creating selection of records 

15-9
description of 11-9
displaying search conditions 

in 11-2, 11-4
searching in related files 

11-7
using 11-3 to 11-6, 15-9 to 

15-10
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Search in Selection check box 
11-6

searches. See wildcard (@) 
character

Select button 1-5
Select menu

Search menu command 11-3
Sort Selection menu 

command 13-14
selecting records

by searching 11-2
Shift-clicking

for aligning objects 2-7
for selecting objects 1-14

Short date format 1-18, 13-9
single-page layouts 3-2
Size box 2-2

viewing layouts 1-8
Sort button 13-15
sort levels

in quick reports 12-3
Sort menu command 4-3
SORT SELECTION command 

15-11
sorts

ascending 15-11
two level 12-5

Start a New Process check box 
15-13

startup procedure 17-12
Step button 16-8 to 16-10
stepping in debugger 16-5 to 

16-12
Structure access drop-down list 

box 17-9
Structure menu

Edit Field menu command 
5-2

Edit File menu command 8-3
New Field menu command 

4-4
New File menu command 

8-3

Structure menu command 4-4
Structure window

adding fields 4-4
double-clicking fields in 4-5
double-clicking filenames in 

2-2, 4-5
for new databases 1-7

Style menu 4-6
Center menu command 1-11
Left menu command 12-6
Right menu command 12-7, 

13-12 to 13-13
subfields 10-1
Subfile layout 10-10
subfiles

creating 10-3 to 10-7
description of 10-1 to 10-2
entering information in 10-7 

to 10-9
subrecords 10-1 to 10-2

entering additional 10-9
Subtotal function

in scripts 13-10 to 13-12
Sum check box

in quick reports 12-6
Syntax Error window 16-2 to 

16-4
buttons in 16-13 to 16-14
using 16-11 to 16-14

syntax errors
debugging 16-14 to 16-17
description of 16-2

T
templates

Custom 1-3
description of 1-3
input 1-2 to 1-4
output 1-5 to 1-7

Text Area tool/icon 1-10, 4-6, 
13-8

Text with Scroll Bar check box 
10-4
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themes. See routines
tilde (~) character

forcing capitalization 5-3
Total area

in Layout editor 13-3, 13-4
Totals row

in quick reports 12-3, 12-6
Trace button 16-14
TRACE command 16-3 to 16-4
triangles, indicating scripts 6-7
Type function 16-14 to 16-15

U
Undo menu command 1-10

cancelling alignment 1-15, 
2-7

correcting mistakes in the 
Layout editor 1-8

Use menu
Design menu command 

13-4, 17-12
for changing environments 

15-6
User menu command 1-21, 

2-8, 4-8, 5-9, 9-4
User environment 11-3

changing layouts in 3-6
data validation in 5-9
layouts in 1-21 to 1-22
moving to and from 15-6
using choice lists in 4-8
using custom buttons in 2-8

User menu command
changing environments 

1-21
User Modifiable menu command 

4-3
users

adding 17-3 to 17-6
Administrator 17-2
assigning to groups 17-6 to 

17-7
Designer 17-2

in password access system 
17-2 to 17-3

removing from groups 17-7
Users box 17-3
Users list 17-6

V
validation ranges, adding 5-6
Value line 11-3
values

in search conditions 11-2

W
wildcard (@) character

searches in related files 11-8
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